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Preface 
 

Survey Data Processing consists of verifying, coordinating, formatting and processing full field 

survey data, field mapping enhancement data, additional survey data and existing right of way and 

property data.  This data is then submitted to end users as planimetric MicroStation (.DGN) files, 

Topographic 3D Digital Terrain Model (.DTM) files and Geometry Project (.ALG) files in InRoads. 

The digital field/mapping data is used as a database in the development of highway project plans.    

 

These Survey Data Processing Guidelines have been developed as part of the statewide GDOT 

implementation of MicroStation V8i and InRoads V8i Select Series 2. The intent of this document 

is to provide guidelines and standards for processing survey data in InRoads V8i Select Series 2.  

These guidelines must be followed in detail in order to conform to the current GDOT standards for 

producing the required survey data deliverables.  Updates to this document will be made periodically 

when minor revisions, additional information, and/or enhancements are added. 

 

 

 

If there is any approved deviation from the standard file and data naming/feature style conventions 

as prescribed by this document - a detailed description of the deviation(s) and approved reasons 

for the deviation(s) shall be documented and included with the project files in electronic format. 
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Contact Information 
 

To submit any comments or questions regarding the information contained in this document, please 

contact the Office of Design Policy & Support by email at the following address: 

 

SolutionsCenter@dot.ga.gov  

 

In the Email Subject Header, please reference the InRoads Survey Data Processing Guidelines 
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Overview 
 

These Guidelines cover the GDOT standards for processing Survey Data by utilizing the 

MicroStation V8i and InRoads V8i Select Series 2 software(s).  These procedures depict the Project 

Initialization Standards and Conventions to create an InRoads Survey Project to GDOT format and 

the processes to create/generate the files which are to be submitted as deliverables to the Design 

Engineer. 

 

For detailed Survey Data Processing instructions please refer to the Training Manual:  

Introduction to InRoads for Survey Data Processing  

 

Document Content 

Below is a list of topics covered in this document: 

 

 Project Initialization Standards 

 Standard Conventions 

 Surface and Property Data Information 

 Survey Data Project Deliverables 

 Additional Survey Enhancements 

 Appendix A  

 Appendix B 

 Appendix C 
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Project Initialization Standards 
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1. Project Initialization Standards 

Project Initialization Standards have been established in order to promote consistency and assist in the 

organization of project data.  These standard project schemes help to ensure uniformity for all users 

who may work on the project.  

 
This section covers the following topics: 

 

● GDOT Standard Files (MicroStation and InRoads) 

● Standard Project Structure 

● Starting MicroStation V8i and InRoads V8i Select Series 2 

● Overview of InRoads Interface 

● InRoads Project Defaults 

● Survey Default Preferences 

● InRoads “Locks” 

● Application and Variable Manager Add-Ins 

● Initiating a Survey Project in InRoads 
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1.1 GDOT Standard Files –MicroStation and InRoads  
In order to conform to current policy for plan deliverables – GDOT provides the requisite files 

needed to standardize InRoads and MicroStation to GDOT requirements.  The first step in the 

development of an InRoads and MicroStation Project is to ensure that these standard files are 

being utilized.  Instructions for downloading/installing the executables are included on the 

GDOT web page (see the links depicted below).  These files are required for any Survey Data 

Projects generated for GDOT.    

 

 MicroStation Standard Files Location For Internal GDOT Users – a server location has 

been established to map a drive (an N:\ Drive)  in order to access the latest MicroStation 

Files. Once the internal user maps the N:\ drive – all of the standard MicroStation Files will 

be available through this mapped drive. 

 

 MicroStation Standard Files Location For External Users -   a  MicroStation  

    (CaddALL.exe) executable file is available and located in a download   

     executable which can be accessed from the GDOT web page. This executable  

contains all of the GDOT MicroStation V8i Select Series 2 standard files. This file can be 

downloaded by navigating to the MicroStation and InRoads links from the following 

location:     

 
 http://www.dot.ga.gov/PS/DesignSoftware/Microstation 
 

InRoads Standard Files Location For Internal and External Users -  an InRoadsALL 

     executable file (InRoadsALL.exe) is available and located in a download   

     executable which can be accessed from the GDOT web page. This executable  

contains all of the GDOT InRoads V8i Select Series 2 standard files. This file can be 

downloaded by navigating to the MicroStation and InRoads links from the following 

location:      

 
   http://www.dot.ga.gov/PS/DesignSoftware/InRoads 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.dot.ga.gov/PS/DesignSoftware/Microstation
http://www.dot.ga.gov/PS/DesignSoftware/Microstation
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/software/Pages/default.aspx
http://www.dot.ga.gov/PS/DesignSoftware/InRoads
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The InRoadsALL.exe file contains all of the standard GDOT files which are required to 

generate projects to GDOT standards. The user will perform the following steps to extract 

and set-up the GDOT Standard InRoads Files: 

 

1. Close MicroStation V8i and InRoads V8i Select Series 2 if they are still open. 

 

2. Navigate to the InRoads links from the following web page:  

 

3. Save the InRoadsALL.exe file to the hard drive and then double click the file.  

http://www.dot.ga.gov/PS/DesignSoftware/InRoads 

 

4. The self-extractor will download the GDOT InRoads Standard Files to the following 

locations:  

a. C:\InRoads Data\Standards\ 
 GDOT_Standard V8i_SS2.xin 

 GDOT_Standard V8i_SS2.itl 

 Project_Data_Sheet_MultipleAlign.xlsx 

 Photogrammetry_InRoads QA.pdf 

 Survey Data Processing_InRoads QA.pdf 

 Design Data_ InRoads QA.pdf 

 GDOT (PI#) Pay Item Database.mdb 

 

b. C:\InRoads Data\Component Documentation 
 GDOT Component Description Help Documentation 

 

c. C:\InRoads Data\Style Sheet Documentation 
 GDOT Style Sheet Help Documentation 

 

d. C:\InRoads Data\Style Sheets\GDOT\ 
 GDOT Style Sheets 

 

5. For detailed instructions on downloading and installing InRoadsALL.exe - navigate 

to the InRoads links from the GDOT web page and click on the Downloading and 

Running InRoadsALL.pdf document for installing these standard files. 

 

 

 

 

 

 

 

 

 

 

 

http://www.dot.ga.gov/PS/DesignSoftware/InRoads
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1.2 Standard Project Structure 
The standard File Structure for InRoads is a Project Folder (which is named for the PI # of the 

Project – Example:  1234567) located as a sub-folder under C:\InRoads Data – Example: 

C:\InRoads Data\1234567.  The Project Files are then located in an SDE sub-folder under the PI 

# – Example: C:\InRoads Data\1234567\SDE -- This Project Folder contains the individual 

InRoads Data Files. (See Table 1.1) 

 

 

Table 1.1 

InRoads Project Structure 

 

InRoads Project Structure C:\InRoads Data\PI Number\ SDE 

 

InRoads Project Structure 

(Example) 

C:\InRoads Data\1234567\ SDE 

 

 

  Some examples of InRoads Data File Types are: 

 

1. .DTM ------- (Digital Terrain Model File) – contains Surface data 

2. .FWD ------- (Survey File) – contains Field Survey data 

3. .ALG-------- (Geometry File) – contains Geometric Point, Horizontal and Vertical data 

4. .IRD -------- (Roadway Design File) – contains the Design Surface data 

5. .RWK------- (Project File) – contains project data for InRoads files in ASCII format 

6. .ITL--------- (InRoads Template File) – contains InRoads Templates for cross-sections 

7. .SDB-------- (Drainage File) – contains the InRoads Storm and Sanitary data   

 

Although InRoads consists of the above file types -- the “Survey Data” will usually consist of the 

following file types and will be located in the C:\InRoads Data\PI Number\SDE folder: 

 

 Processed DTM Surface file (PI#_ SDE.dtm) 

 Processed ALG Geometry File (PI#_ SDE.alg) 

 Processed FWD Survey File(s) (PI#_A.fwd, PI#_B.fwd, PI#_XO.fwd, etc) 

 Processed Property DGN file (PI#_PROP.dgn) 

 Processed Topographical DGN file (PI#_TOPO.dgn) 

 Processed Utility DGN file (PI#_UTLE.dgn) 

 

 

 

 

 

 

 

It is highly recommended to backup the Project Folder (which contains these individual data 

files) after each work session to your Group Account on the GDOT Server if you are a GDOT 

Employee (or to an appropriate Business Server if you are a GDOT Consultant).  
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1.3 Starting a Survey Project in InRoads 
After creating the Survey Project folder of C:\InRoads Data\PI Number\SDE – the 

Surveyor/SDE will then copy the Standards folder (which is downloaded through the 

InRoadsALL.exe executable) to the C:\InRoads Data\PI Number\SDE folder. 

  

1.3.1 Copy the “Standards” folder which is downloaded from InRoadsALL.exe 

 

Important Step:  

After installing InRoadsALL.exe – the user will copy the Standards folder under 

C:\InRoads Data\ to the Project Location. The rest of the Standard Files will remain in the 

default install location.  

 

Whenever a new Project is created – the Surveyor/SDE will download and install 

InRoadsALL.exe. The files will be extracted to the Default Location(s). The reason for the 

install is to ensure the user has the latest published XIN File. The Surveyor/SDE will then 

perform the following step: 

 

 

 The user will copy the C:\InRoads Data\Standards Folder to the InRoads Data\PI# \ 

SDE folder. (Example: C:\InRoads Data\1234567\SDE\Standards).   

 

 

Table 1.2 

Copy Standards Folder to Project Folder  

C:\InRoads Data\Standards Copy To  C:\InRoads Data\PI #\SDE  
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1.4 Starting MicroStation V8i and InRoads V8i 
The user will be working in both MicroStation V8i Select Series 2 (the CADD Software) and 

InRoads Suite V8i Select Series 2 (the Survey/Design Software).  The MicroStation CADD 

Software is used for the viewing and manipulation of graphics derived from InRoads. The 

InRoads Software is the database in which the Surveying data is created and processed.  The 

user will select the standard GDOT 3D “seed” file to use as the “seed” DGN  in order to create 

the three dimensional “Working” DGN file.  This “Working” DGN file is used to display the 

temporary and/or permanent graphics in InRoads.  

 

 This section details the following processes: 

  

● Steps to Create a Survey “Working” DGN File 

● Steps to Open an Existing Survey “Working” DGN File 

 

 

The “Working” DGN file will be saved to the following folder location: 

C:\InRoads Data\PI Number\ SDE\Standards 

 

 

Table 1.3 

Standard Naming Convention of the “Working” DGN File 

 

Working DGN File Name C:\InRoads Data\PI Number\SDE\Standards 

 

GDOT 3D Working File.dgn  

 

 

 

The MicroStation software will open first before InRoads. After the MicroStation Splash Screen 

appears, the MicroStation Manager dialog (See Figure 1-1) will open so that a “Working” DGN 

file can be created or an existing “Working” DGN file can be opened. The InRoads software can 

then be initiated.   
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1.4.1 Steps to Create a Survey “Working” DGN File 

 The Survey “Working” DGN file will be created from the GDOT_V8_3D.dgn seed file.   

  

 Please Note:  The current seed file in the MicroStation configuration defaults to a 2D Seed 

File. In order to view spikes in the DTM and for additional 3D Checks, the user will need to 

browse to select the 3D Seed file as depicted in the steps below.  Following are the steps to 

create a Survey “Working” DGN File: 

 

1. From the desktop, double-click on the GDOT MicroStation V8i SS2 (x86) icon.  

 

 

 

  

 

 

 

2. After the MicroStation Splash Screen appears, the MicroStation Manager dialog box 

will open. (See Figure 1-1).   

 

 

 

 
 

                      Figure 1-1   Starting MicroStation V8i and InRoads V8i 

3. In the MicroStation Manager dialog box, click on the New File icon  (See 

Figure 1-1) depicted above. The New File command will be used to create the 

“Working” DGN file. 

Double click on the 

icon labeled 

GDOT MicroStation 

V8i SS2 (x86). 

New File Icon 
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4. After the New File   command is selected, the MicroStation New File dialog box 

will open. (See Figure 1-2).   

 Click in the Save in: Pulldown - and browse to the C:\InRoads Data\PI Number\  

       SDE\Standards location to save the new “Working” DGN file 

 In the File name: Pulldown – enter GDOT 3D Working File.dgn  

 In the Save as type: Pulldown – select MicroStation DGN Files (*.dgn) 

 In the Seed: Field  - Click the Browse button to select the seed file named   

       GDOT_V8_3D.dgn  
 

The inputs should now be similar to the screen capture depicted in Figure 1-2 (as shown 

below).   

 

   
 

Figure 1-2   MicroStation New File Window 

5. Click the Save command button and the MicroStation Manager dialog box will 

appear. 

 

6. In the MicroStation Manager Dialog box – highlight the file just created (GDOT 3D 

Working File.dgn) and click the Open button. 

 

7. The MicroStation V8i Select Series 2 interface will then finish opening. 

 

8.  In the Main MicroStation Pull-down Menu – click on the following InRoads pull-

downs:  
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9. Select InRoads InRoads Suite (SELECTseries 2) V8i 08.11.07.566— and the 

InRoads V8i Select Series 2 interface will open. Once InRoads and MicroStation are 

up and running, the desktop should look similar to that of Figure 1-3 and Figure 1-4.  

 

 
                                              Figure 1-3   Main MicroStation V8i Window 

   

 

 

 

                                               Figure 1-4   Main InRoads V8i Window 
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1.4.2 Steps to open an existing Survey “Working” DGN File 

 If the Survey “Working” DGN file has been created previously – use the following steps to 

open a Survey “Working” DGN File: 

 

 

1. From the desktop, double-click on the GDOT MicroStation V8i SS2 (x86) icon.  

 

 

 

 

 

 

 

2. After the MicroStation Splash Screen appears, the MicroStation Manager dialog  

box will open. (See Figure 1-5).       

     
                        Figure 1-5   Starting MicroStation V8i and InRoads V8i 

3. In the MicroStation Manager dialog box, browse to the C:\InRoads Data\PI Number\ 

SDE\Standards location and highlight the (GDOT 3D Working File.dgn) and click the 

Open button. 

 

4.  The MicroStation V8i Select Series 2 interface will then finish opening. Then select 

InRoads InRoads Suite (SELECTseries 2) V8i 08.11.07.566— and the InRoads 

V8i Select Series 2 interface will open. Once InRoads and MicroStation are up and 

running, the desktop should look similar to that of previous screen captures Figure 1-3 

and Figure 1-4.  

Double click on the icon 

labeled 

GDOT MicroStation  

V8i SS2 (x86). 
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1.5 Overview of InRoads Interface 
As mentioned previously - the user will be working in both the InRoads Design Software and the 

MicroStation CADD Software.  The InRoads Software is the database in which the Surveying 

data is created and processed.    

 

 

Shown below is a diagram which depicts the InRoads Explorer objects and a brief overview of 

the InRoads Explorer Interface: 

 

 

 

 

 

 
 

 

 

 

 

 

 

 Workspace Bar – Contains all of the InRoads Project Data information   

 Menu Bar – Contains the pull-down menus to access InRoads commands  

 Toolbars – Contains default and customized toolbars to access InRoads commands 

 Feedback Pane – Contains details of selected Project Data from the Workspace Bar 

 Scroll Bar – Enables the user to view more of the InRoads Explorer Interface. (The Scroll 

Bar may not be visible if the InRoads Interface is already viewed to extents). 

 Status Bar – Contains InRoads messages and prompts (Please note:  InRoads may direct you 

to locate something graphically in MicroStation -- some of these prompts may display in the 

MicroStation Status Bar instead).  It is very important that the user review both the InRoads 

and the MicroStation Status Bar for prompts and information. 

 

 

 

Menu Bar Toolbars 

Status Bar Scroll Bar 

Workspace 

Bar 

Feedback 

Pane 



Project Initialization Standards   InRoads Survey Data Processing Guidelines SS2 

 

1-13 

 

1.6 InRoads Project Defaults 
The InRoads Project Defaults setting allows you to define the “default folder locations” for 

projects.  A Project Default configuration can then be saved for each project so that multiple 

projects can be accessed.  This configuration allows you to easily navigate between projects. Once 

the Project Folder locations are saved in the Configuration, the projects can then be accessed by 

selecting the appropriate Project Configuration Name.  The Project Defaults also contain the 

location for selecting the standard GDOT InRoads Preference File (GDOT_Standard 

V8i_SS2.xin). 

 

The standard Project Default configuration for Survey projects will be PI#_SDE. Each Survey 

Project Default will consist of this naming structure in order to easily navigate between projects. 

(See Table 1.4)  

 

**Once the Project Default Location is set for a particular project – this will also be the default 

folder location whenever the InRoads commands of FileSave and FileClose are used.   

 

Table 1.4 

Project Defaults Configuration 

Project Default Structure PI Number_SDE 

 
Project Default Structure (Example) 1234567_SDE 

 
 

 Following are the steps to create a Survey Project Default Configuration 

 (Substitute the appropriate PI # as required): 

 

1. Click FileProject Defaults from the InRoads pull-down menu to access the Set Project 

Defaults dialog box. 

 

2. Click New and enter 1234567_SDE in the New Configuration dialog box. Then click 

OK. 

 

3. Under the Default Preferences section - Click in the Preferences (*.xin): field and 

then click the Browse button to navigate to the following file:   

C:\\InRoads Data\1234567\SDE\Standards\GDOT_Standard V8i_SS2.xin file and 

click Open. 
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4. Under the Default Directory Paths Section - Click in the Project Default Directory: 

field and then click the Browse button to navigate to the folder:  

C:\InRoads Data\1234567\SDE\. Next - click Open. 

 

5. Under the Default Directory Paths Section – copy and paste the following text into 

each entry field shown below: C:\InRoads Data\1234567\SDE\  

 

 Report Directory: - C:\InRoads Data\1234567\ SDE \ 

 Projects (*.rwk): - C:\InRoads Data\1234567\ SDE \ 

 Surfaces(*.dtm): - C:\InRoads Data\1234567\ SDE \ 

 Geometry Projects: (*.alg): - C:\InRoads Data\1234567\ SDE \ 

 Template Libraries:(*.itl): - C:\InRoads Data\1234567\ SDE \ 

 Roadway Design: (*.ird): - C:\InRoads Data\1234567\ SDE \ 

 Survey Data: (*.fwd): - C:\InRoads Data\1234567\ SDE \ 

 Drainage: (*.sdb): - C:\InRoads Data\1234567\ SDE \ 

 Quantity Manager: (*.mdb): - C:\InRoads Data\1234567\ SDE\ 

 Site Modeler Projects (*.gsf): - C:\InRoads Data\1234567\ SDE\ 

 

6. Under the Default Directory Paths Section - Click in the Style Sheet (*.xsl): field and 

then click the Browse button to navigate to the folder:  

C:\InRoads Data\Style Sheets\GDOT\.  Next - click Open. 
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Figure 1-6   Project Defaults 

7.  The Project Defaults should look similar to the screen capture depicted in Figure 1-6 

(as shown above).  Click Apply and then click Close.  

 

 

 

 

 

 

 

 

 

 

Ensure that the 

“Preferred Preference” 

is set to “Survey Default”. 
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1.7 Survey Default Preferences 
The Survey Default Preferences must be loaded in InRoads in order to conform to standards for 

the processing of Survey/Mapping Projects.  This is a very important step to ensure that standards 

are followed for any Survey or Photogrammetric data that will be processed. The Survey Default 

Preference loads the Precision Settings, Tolerances, Units and Formats, Default Point and 

Alignment Numbering scheme(s), etc.  Once the Survey Default Preference is loaded – the project 

will retain these settings each time the project is accessed.   

 

Following are the steps to set the Survey Default Preferences: 

 

1. Click File Project Options from the InRoads pull-down menu to access the Project 

Options dialog box.   

 

2. In the Project Options dialog box - click on the General Tab and the General Tab 

dialog box will appear.   

 

                                
 

 

 

 

3. In the General Tab dialog box click the command button named Preferences… 

(Located at the bottom of the dialog box) and the Preferences dialog box will open. 

 

                                                                      
                                                                                                            

 

 

 

 

 

 

 

4. In the Preferences dialog box – select Survey Default.  Then click Load and then 

click Close.  

 

5. The Survey Default Preference should now correspond to the screen capture depicted 

in Figure 1-7 (as shown below). 

General Tab 
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                                                     Figure 1-7   Survey Default Settings 

 

 

6. Click Apply and then click Close.  

 

The Survey Default Preference is now loaded. This Preference loads the appropriate data for ALL 

of the tabs in the Options dialog box. The individual tabs (Tolerances, Geometry, Units and 

Format, etc.) will automatically be configured for use in Survey calculations. The Point and 

Alignment Numbering scheme(s) are also automatically configured for the standard Survey 

conventions in the Survey Default Preference.  These individual tab options will NOT need to 

change. Once the Survey Default Preference is loaded – the project will retain these settings each 

time the project is accessed on this computer. These settings are specific to this computer 

Profile/XIN file. If the Project is accessed on another computer – these settings may need to be re-

applied in order to load the correct Survey Default Preference.    

 

 

 

 

 

 

 

Ensure that the “Refresh 

Command Settings on 

Preference Change” is 

checked: 
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1.8 InRoads “Locks” 
InRoads contains several “Locks” which are used by many InRoads commands to control different 

aspects of the selection and viewing of data as well as the reporting of data.  There are basically 

two types of “Locks” – On/Off “Locks” and Switch “Locks”. (Switch “Locks” contain different 

modes but one mode is always active and the user can switch between modes). Both types of 

“Locks” can be changed by the user as the situation dictates during the course of the database 

generation.  These locks affect many commands – so it is very important that the user understand 

the use of these locks.  If an InRoads command does not function as expected when utilizing the 

Surface Viewing or Reporting commands -- a “Lock” may have been inadvertently turned on/off. 

 

The following section contains a brief overview of some of the InRoads “Locks”.  Only the 

“Locks” pertaining to the Survey aspect will be reviewed.  As mentioned previously the “Locks” 

may be changed as situations dictate – but the settings depicted in the following section are 

applicable for most Survey Projects.   It is a very important step to ensure that the “Locks” are set 

accordingly. (See Table 1.5)   

 

Following are the steps to access the InRoads “Locks”: 

 

Click ToolsLocks from the InRoads pull-down menu.  Each time a “Lock” is changed – the 

pull-down menu will close and the user must click on ToolsLocks again to access the Locks 

pull-down. 

 

 

 

Table 1.5 

InRoads Locks Settings 

 

Feature Filter Unchecked 

Feature Highlight Unchecked 

Style Unchecked 

Pencil/Pen         Set to Pencil 

Delete Ink    Unchecked 

Locate Set to Features 

Point Snap Checked 

Element Snap         Unchecked 

Station Unchecked 

Report Checked 

Cogo Audit Trail Unchecked 

Toolbar Checked 

 

Following is a brief overview of the InRoads “Locks”:  
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(See Table 1.6) 

 

 

Table 1.6 

InRoads Locks Overview 

 

Feature Filter   
displays or obscures Surface Features based on a filter (also controls Survey Style Filter) 

 

Feature Highlight 
 highlights the feature in plan view when selected from a list 

 

Style 

 determines if a dialog box is displayed for a surface command or cross sections 

 

Pencil/Pen   
controls the redisplaying of Graphics 

 

Delete Ink  
allows redisplayed graphics to replace graphics in pen mode 

 

Locate    

controls if Locate Buttons snap to Graphics or Features 

 

Point Snap   
 controls the ability to snap to points in Geometry Project 

 

Element Snap 

controls the ability to snap to elements in Geometry Project 

 

Station   
controls the Stationing as it pertains to Cross Sections 

 

Report  
controls if Report is displayed or not displayed in a dialog box                          

 

Cogo Audit Trail  
controls the reporting of coordinate geometry results to a text file 

 

Toolbar 

displays or turns off the Locks Toolbar 
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1.9 Application and Variable Manager Add-Ins 
InRoads contains several Application and Variable Manager “Add-Ins” which must be selected 

and added to the InRoads Program in order to access the standard GDOT customized menu 

applications/translators for Survey.  Once the Application and Variable Manager Add-Ins are 

selected – the settings are written to registry keys in the user’s profile.  This ensures that each time 

InRoads is accessed in the user profile -- these settings will already be available. These add-ins 

will only need to be added once and will then be accessible in all of the InRoads Modules and 

InRoads Projects.   

 

The “Application and Variable Manager Add-Ins” must be set accordingly in order to access the 

required GDOT Survey commands and translators.    

 

 This section details the following processes: 

  

● Steps to select the Application Add-Ins 

● Steps to select the Variable Manager Add-Ins 

1.9.1 Steps to select the Application Add-Ins:  

 

1. Click ToolsApplication Add-Ins from the InRoads pull-down menu and the following 

dialog box will appear:   

 

 
 

2. Select the following Application Add-Ins by clicking an         by the appropriate Add-

In: 

 

 

 

 

 

 

 

 

 

 

 

3. Click OK to accept the settings and to close out of the dialog box. 



Project Initialization Standards   InRoads Survey Data Processing Guidelines SS2 

 

1-21 

 

1.9.2 Steps to select the Variable Manager Add-Ins:  

 

1. Click ToolsVariable Manager from the InRoads pull-down menu and the following 

dialog box will appear:   

 

 
 

 

2. Select the following Variable Manager Add-Ins by clicking an          by the appropriate 

Variable:  

 

 

                           
 

 

3. Click Apply to accept the settings and then click Close to close out of the dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

      2. 
Standard Conventions 
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2. Standard Conventions 

This section provides an overview of the GDOT standard Project, File and Object naming 

conventions.  The standard Feature Types for DTM (Digital Terrain Model) data are discussed and 

the GDOT Preference File (.XIN) is reviewed. Feature Code Tables are also listed which provide 

the standard Feature Codes/Feature Styles to utilize for Photogrammetric and/or Field Survey 

Projects.  

 
This section covers the following topics: 

 

● Project, File and Object Naming Conventions 

● Standard Surface Feature Object Names 

● Standard Surface Feature Types 

● Standard Geometry Object Names 

● Standard File Information 

● Standard Preference File (XIN) and GDOT Preferences 

● GDOT Standard InRoads Photogrammetry Feature Codes 

● GDOT Standard InRoads Field Survey Feature Codes 
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2.1 Project, File and Object Naming Conventions 
As mentioned previously in Section One - in order to ensure Project and File Naming 

consistency – standard Project, File and Object Naming conventions have been established.   

 

 This section details the following Standard Naming Conventions: 

  

● Standard Project Naming Conventions 

● Standard File Naming Conventions 

● Standard Object Naming Conventions 

 

** Important Conventions regarding CSV File Import: 

 

InRoads contains a CSV file importer which converts the CSV file(s) into a format that is 

usable for InRoads.  The .CSV file is imported based on a format of Point Number, 

Northing, Easting, Elevation, Feature Code and Attribute.  After the CSV file(s) are 

imported into the Field Book, the data can then be exported into a Surface Project and/or 

Geometry Project.   

 

2.1.1 Standard Project Naming Conventions 

The standard File Structure for InRoads is a Project Folder named for the PI Number of the 

project.  A sub-folder – named SDE – will be located under this PI Number. This is the folder 

location where the core Survey File data is located. When submitting project deliverables to 

the Designer – submit the entire Project Folder (Example: the PI Number Folder and the 

associated SDE sub-folder). This will ensure that all of the applicable files are submitted to 

the end-user. (See Table 2.1)  

 

Table 2.1 

Standard Project Naming Conventions 

 

InRoads Project Structure C:\InRoads Data\PI Number\ SDE 

 

InRoads Project Structure 

(Example) 

C:\InRoads Data\1234567\ SDE 
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2.1.2 Standard File Naming Conventions 

 InRoads contains several different file types but the Survey data will usually consist of file 

types pertaining to the .CSV (Survey Trimble File), .FWD (Survey Field Book), the .DTM 

(Digital Terrain Model), the .ALG (Geometry File) and the associated topographical .DGN 

(MicroStation Design File) deliverables.  Following are the applicable file naming 

conventions (See Table 2.2) 

  

 Table 2.2 

 Standard File Naming Conventions 

 

 File Type File Name 

  3D “Working”  DGN file GDOT 3D Working File.dgn  

  CSV – Full Field Survey File 

 

1st  (Original) Field Survey CSV 

2nd  Enhancement Field Survey CSV  

3rd Enhancement Field Survey CSV, Etc. 

 

  

 

PI#A.csv              

PI#B.csv              

PI#C.csv, Etc.      

  CSV – Mapping Enhancement File 

 

Original Mapping Enhancement CSV 

1st  Mapping Enhancement CSV 

2nd Mapping Enhancement CSV, Etc. 

 

 

 

PI#XO.csv           

PI#XA.csv           

PI#XB.csv, Etc.   

  FWD – Full Field Survey File 

 

1st  (Original) Field Survey File 

2nd  Enhancement Field Survey File 

3rd  Enhancement Field Survey File, Etc. 

 

  

 

PI#_ A.fwd 

PI#_ B.fwd 

PI#_ C.fwd, Etc. 

  

  FWD – Mapping Enhancement File 

 

Original Mapping Enhancement File 

1st Mapping Enhancement File 

2nd  Mapping Enhancement File, Etc. 

  

 

  

 

PI#_ XO.fwd 

PI#_ XA.fwd 

PI#_ XB.fwd, Etc. 
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 Table 2.2 

 Standard File Naming Conventions 

 

 File Type File Name 

  ALG - Geometry File PI#_ SDE.alg 

  DTM - Processed DTM Surface File 

(All DTM’s are incorporated into this one 

Existing DTM before submission) 

Note:  

(A PI#_Map.dtm will be provided by 

Photogrammetry if the project is Mapping. Please 

see the SDE Training Lab 8A for the process to 

copy the Mapping DTM into the PI#_SDE.dtm 

before adding enhancements).   

PI#_ SDE.dtm  

 

 

 

 

               See Note: 

  
Intermediate DTM – Full Field Survey File 

 

Note:  

(The First Original Field Survey File is obtained 

from the PI#A.csv and PI#_A.fwd files. These files 

are incorporated as PI#_SDE.dtm during initial 

DTM creation – therefore there is no intermediate 

DTM named PI#_A.dtm.) 

 

2nd   Enhancement Field Survey File 

3rd  Enhancement Field Survey File, Etc. 

 

  

 

  

 



                 See Note: 

 

 

 

 

PI#_ B.dtm 

PI#_ C.dtm, etc. 

 

  Intermediate DTM – Mapping File 

 

Original Mapping Enhancement DTM 

1st  Mapping Enhancement DTM 

2nd  Mapping Enhancement DTM, Etc. 

 

  

 

PI#_ XO.dtm 

PI#_ XA.dtm 

PI#_ XB.dtm, etc. 

  

  Processed DGN Files PI#_TOPO.dgn 

PI#_UTLE.dgn 

PI#_PROP.dgn 

  Processed DGN PDF Plot Files PI#_TOPO.pdf 

PI#_UTLE.pdf 

PI#_PROP.pdf 
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2.1.3 Standard Object Naming Conventions 

 InRoads contains several different object types such as DTM Feature Points and Alignments, 

Cogo Points, Alignment Points and Alignments.  Following are the applicable object naming 

conventions (See Tables 2.3 – 2.5). 

 

 

Table 2.3 

Example Standard Object Names 
 

Object Type Object Name Object Name Convention 

Mapping Feature Points and 

Alignments 

Example:  M_TPBL224 Feature Code & Number 

Field Feature Points and 

Alignments 

Example:TOPO_E_TPBL-1 

 

Feature Code Style & Number 

Cogo Points Example: 1789 --- (No Prefix) Point # only – No Prefix 

Alignment Points Example: 1790 --- (No Prefix) Point # only – No Prefix 

Alignments Example: SV23--- (SV Prefix) Prefix + Alignment # 

 

 

Table 2.4 

Example Exterior Boundary Naming Conventions 
 

Exterior Boundary Type Feature Name Feature Style 

Mapping Exterior Boundary MBOUNDARY TOPO_E_TLIML 

Full Field Survey Boundary XBOUNDARY TOPO_E_TLIML 

 

 

 

Table 2.5 

Point & Alignment Ranges to Use 
 

Points Range 1-9999 

Alignments No Limitations for Alignments -- but must have the SV Prefix 
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2.2 Standard Surface Feature Object Names 
 

      Mapping and Field Data: 

InRoads contains an ImportSurface Advanced command which imports the 3D 

Photogrammetric Data from the Softcopy MicroStation DGN file into a format that is usable 

for InRoads.  The Surface Advanced command imports the 3D DGN elements into InRoads 

based on the Level of the Features in MicroStation as well as the Level and Cell for Random 

Terrain Points. (The SDE will receive this data already imported into the DTM. This DTM 

Surface will be provided to the SDE as PI#_ Map.dtm). 

The CSV (Field Data Collector) files are imported directly into InRoads through an internal 

Import Survey Data Translator. After the CSV file is translated and imported into the Field 

Book, the data can then be exported into a Surface Project and/or Geometry Project.  The 

processing and triangulating of the Surface Data/Geometry Data are discussed and 

demonstrated in the Introduction to InRoads for Survey Data Processing. 

 

The CSV data is imported in as surface features into a surface. Each Feature object is 

assigned a hard coded unique naming scheme based on the Feature Style – Example: 

TOPO_E_TPBL-1, TOPO_E_TPBL-2, TOPO_E_TPBL-3, etc. for Field Survey DTM data. 

(See Table 2.6). The internal surface points are numbered consecutively in the particular 

Feature Object - Example: 1, 2, 3, etc. Each Feature can be made up of one or many points. 

The Feature Style is based on the associated Feature/Alpha Code and is assigned during the 

CSV Import Translation process. The Feature Style determines if the Feature will be included 

in the triangulation process. 

The Feature Type affects how the DTM triangles are formed. The Feature Type can be a 

breakline, random point, etc. and is determined based on a setting in the corresponding 

Feature Style. The attribute of the Surface Feature (whether it is 3D topographic or a 2D 

planimetric Feature) and the triangulation effect is also determined during the translation 

process. 

 The Standard Object Names for the Surface Features are determined by the Feature 

Code/Feature Style – this is an automated process so that the Standard Object Names are 

already defined for the user.  (See Table 2.6) 

  

Table 2.6 

Example DTM Feature Object Names 
 

Mapping Feature Points and 

Alignments 

Example:  M_TPBL224 

Field Feature Points and 

Alignments 

Example:  TOPO_E_TPBL-224 
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2.3 Standard Surface Feature Types 
InRoads contains five Feature Types:  Breakline, Random, Contour, Interior and Exterior. 

These Feature Point Types are set according to the corresponding Feature Code/Feature Style in 

the standard GDOT Preferences file (GDOT_Standard V8i_SS2.xin). As mentioned 

previously, the Feature Point Type determines how DTM triangles are formed when the points 

are connected. When the data in the CSV file is imported during the translation process – the 

correct Feature Type is automatically assigned by the Feature Style and to the Feature Object 

which is imported into the Surface. Following are examples of the Feature Types: (See Table 

2.7) 

 

Table 2.7 

Example Surface Feature Types 

 

Feature Type Description 

Breakline Linear connected points that represent 

discontinuities in a surface 

Random Randomly spaced points that are independent of 

other points 

Contour Connected points that form a linear segment based 

on elevation 

Interior Interior connected points that represent areas in a 

DTM that are undefined or obscured   

Exterior Exterior connected points that represent the outer 

limits of a DTM surface and can be used to trim 

extraneous triangulated data 
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2.4 Standard Geometry Object Names 
 

As mentioned previously - the CSV (Field Data Collector) files are imported directly into 

InRoads through an internal Import Survey Data Translator.   After the CSV file is translated 

and imported into the Field Book, the data can then be imported into a Surface Project and/or 

Geometry Project.  The processing and triangulating of the Surface Data/Geometry Data are 

discussed and demonstrated in the Introduction to InRoads for Survey Data Processing 

Training Guide. The previous Section described the data which is imported into the DTM 

Surface. The following Section depicts the data which is imported into the Geometry project. 

The survey data which is imported into the Geometry Project (.ALG) is survey that consists 

of Property data, Existing Right of Way, Alignment data, etc.  Basically it is survey which is 

“Geometry related” and which will be used in the creation of the property, alignment and 

COGO database.  This Geometry data will not be represented in the DTM. All other Survey 

Data will be imported into the Surface Project (.DTM) and will be represented as Surface 

Features. Please see the Introduction to InRoads for Survey Data Processing which depicts 

the process to filter data to import into the Geometry Project (.ALG). 

 

The following codes/styles (which are composed of data which will be used for the generation 

of Property and Alignment information) are included in the Survey Style Filter which is 

named Property and Alignment Codes.  All Codes which are not listed in the table below– 

will be imported into the Surface Project (.DTM File).  The Survey Control Codes are 

imported into both the .ALG and the .DTM Files. 

  

  

 

Property and Alignment Codes Survey Style Filter 

PROP_E_RWM Right-of-Way Marker Found PROP_E_BSL State Line 
PROP_E_RWC Right-of-Way Point Computed TOPO_E_SNGSCM NGS Control Mon. 
PROP_E_RWU Right-of-Way Utility Company TOPO_E_SLCM Loc. Cont. Mon. 

PROP_E_RWE Right-of-Way Prescription Pt TOPO_E_SLCD Loc. Cont. Delta 

PROP_E_POEL Point on Easement Line TOPO_E_SDCD Dist. Cont. Delta 

PROP_E_PCF Property Corner Found TOPO_E_SCCHK Cont. Re-shot 

PROP_E_PPOL Property Point on Line TOPO_E_SBNCHMK Benchmark 

PROP_E_PPC Property Point Computed   

PROP_E_APOT Point in Tangent, Existing   

PROP_E_APC Point of Curvature, Existing   

PROP_E_APOC Point on Curve, Existing   

PROP_E_APT Point of Tangency, Existing   

PROP_E_API Point of Intersection   

PROP_E_ACL Alignment Centerline   

PROP_E_BCOL County Line   

PROP_E_BCTL City Limit Line   

PROP_E_BGMD Georgia Militia District Line   

PROP_E_BLDL Land District Line   

PROP_E_BLLL Land Lot Line   
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A. Geometry Object Names: 

The Geometry Objects consist of Cogo Points, Alignment Points and Alignments. Existing 

Property Data is imported from the Field Survey CSV file. The SDE then utilizes deeds, plats, 

existing plans or tax maps if required to assist in the input of the Parcel and Alignment Data.  

The SDE will store property data by utilizing the existing Cogo Points imported from the CSV 

file and by storing additional Cogo Points, Alignment Points and Alignments computed/based 

off of deeds, plats, etc. as required. 

Please Note:  

The points/chains imported from the CSV file will contain No prefixes. The SDE will also 

store any computed points with No prefixes. Any computed Alignments will be stored with 

an SV prefix to represent a Survey stored Alignment. 

*The reason that Survey (field collected and computed points) do not contain pre-pended 

prefixes is to reduce the possibility of duplicate points going back to the data collector and to 

ensure that duplicate points are not submitted to the Designer when additional enhancements 

are added during the life of the project. Designers will name their computed points and 

alignments with a pre-pended DE prefix in order to differentiate between Survey and Design 

points/alignments. 

 *Please note that it is a requirement for the SDE to pre-pend the SV Prefix to all computed 

Alignments. This includes Parcel Alignments, Existing Centerline Alignments, Existing R/W 

Alignments, etc. 

 

 Cogo Points - These points will be stored with NO Prefix. Only the Point Number will 

be represented. 

 Alignment Points - These points will be stored with NO Prefix. Only the Point Number 

will be represented. 

 Alignments – The Alignments will always be stored with an SV prefix.  

The above Naming Scheme is utilized in order to differentiate between Survey Data and 

Design Data. The Naming Scheme is also used to assist in adding Additional Survey 

Enhancement information to a database. This information can then be submitted to the 

Designer so that the Designer’s Points and Alignments will not be overwritten when 

additional enhancements are added to the Designer’s Geometry Project Database. (See Table 

2.8) 

 

Table 2.8 

Example Standard Object Names 
 

Cogo Points Example: 1789 --- (No Prefix) Point # only – No Prefix 

Alignment Points Example: 1790 --- (No Prefix) Point # only – No Prefix 

Alignments Example: SV23--- (SV Prefix) SV Prefix + Alignment # 
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The following Table depicts the Standard Alignment Descriptions which are required for 

each Alignment stored in the Geometry Project. This Table depicts the Alignment Type, 

Description Convention and the Description Example.   (See Table 2.9) 

 

Table 2.9 

Standard Alignment Descriptions 

 

Alignment Type Description Convention Description Example 

Existing Centerlines EXIST C/L (Roadway Name) EXIST C/L SR 100 

Existing Right-of-Way 

Left 
EXIST R/W LT (Roadway Name) EXIST R/W LT SR100 

Existing Right-of-Way 

Right 
EXIST R/W RT (Roadway Name) EXIST R/W RT SR100 

Land Lots LAND LOT # LAND LOT #102 

Parcels PAR # (Owner Name)   PAR 71 ELLIS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Standard Conventions InRoads Survey Data Processing Guidelines SS2 

2-12 

 

B. Feature Styles to Utilize for Storing Points and Alignments: 

The Standard Feature Styles to use when storing Points and Alignments for the Existing 

Centerline Alignments, Existing R/W, Property, etc. will be named according to the type of 

Point or Alignment which is to be stored. The following Table lists the applicable Feature 

Style(s) to utilize when storing the Point and Alignment data:  (See Table 2.10) 

 

Table 2.10 

Feature Styles For Points and Alignments 

Existing/Computed Points    

PROP_E_ACL                       

PROP_E_ACL-PC-PT 

PROP_E_APC 

PROP_E_API 

PROP_E_APOC 

PROP_E_APOT 

PROP_E_APT 

PROP_E_PCF 

PROP_E_POEL 

PROP_E_PPC 

PROP_E_PPOL 

PROP_E_RWC 

PROP_E_RWE 

PROP_E_RWM 

PROP_E_RWRR 

PROP_E_RWU 

   Existing Centerline Alignment    PROP_E_ACL 

Existing R/W Alignment PROP_E_RWE 

Existing Property (Parcel) Alignment PROP_E_PAR 

 

  

 

C. Point and Alignment Numbering Ranges: 

Point Numbers 1 – 9999 are reserved for survey collecting and survey data processing. Point 

numbering should be done consecutively and if more points are required the numbering 

should continue consecutively as needed. When additional survey data is gathered in the field, 

the point numbers should begin with the lowest number that has not already been submitted 

to design. Designer’s Point numbering range begins at 10,000.  Points 10,000 and above are 

reserved for Design.  If the total number of survey points has reached the 9,999 point limit, 

the Survey Data Engineer should contact the Designer and obtain the next starting point 

number.  

 A gap in point numbering should only exist where the location survey points total less than 

9,999. All other numbering gaps should be minimized.  (See Table 2.11) 

 

Table 2.11 

Point  & Alignment  Numbering Ranges  

Points Range 1-9999 

Alignments No Limitations for Alignments -- but must have the SV Prefix 
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2.5 Standard File Information 
Following is a brief overview of the most common file types the SDE will process and generate: 

(See Table 2.12)   

 

Table 2.12 

Standard File Information Overview 

 

 

GDOT 3D Working File.dgn  
This DGN file is created from the GDOT 3D “seed” file (GDOT_V8_3D.dgn) and is used to display the temporary 

and or/permanent graphics in InRoads. 

 

.CSV  

The .CSV files are comma delimited ASCII format files and contain Field Survey Data collected utilizing Data 

Collectors in the field (Topography, Property, Drainage, etc). The .CSV file is imported into the InRoads .FWD file 

(Electronic Field Book).   

 

.FWD 
 The .FWD file contains the imported Field Survey Data (.CSV File Data). Basically this file is an Electronic Field 

Book in which the .CSV File data is imported so that the survey data can be exported to the .DTM (Surface) and 

.ALG (Geometry) files. 

 

.DTM 
 The .DTM file contains all of the Surface Features imported from the 3D Photogrammetric DGN File and/or CSV 

File(s).  The appropriate Surface Features are triangulated in order to form an Existing Ground Surface (TIN Model) 

for use in Survey and Design. 

 

.ALG 
The .ALG (Geometry File) contains all of the “Geometry” related data imported from the FWD File(s). This data 

is utilized to create Property, Existing R/W and Existing Centerline Alignments for use in Survey and Design. 

 

PI#_TOPO.dgn  
This DGN file contains all of the Topographical and Drainage information generated from Mapping and Full Field 

Survey. 

 

PI#_PROP.dgn  
This DGN file contains all of the Property, Existing R/W, Existing Centerline, etc.., information generated from 

Survey Processing and Field Survey Data. 

 

PI#_UTLE.dgn  
This DGN file contains all of the Utility information generated from Field Survey Data and Mapping. 
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2.6 Standard Preferences 
InRoads Standards for Survey Data Processing has been set up in a “Preference” file (also known 

as an XIN file). This preference file contains the Georgia Department of Transportation’s 

standards for Feature Codes, Feature Styles, Feature Filters, Dialog Box Settings, Linestyles, 

Lineweights, colors, and numerous other settings. The XIN file is basically a compilation of INI 

Files (Initialization files) which controls the standardization of the InRoads settings and display 

options. This preference file is critical for use in the InRoads Survey Process and for accurate 

Digital Terrain Model/ Geometry Objects creation. The XIN file is used in conjunction with 

MicroStation V8i’s ByLevel settings and configuration files to assist in the viewing of project 

data and in the generation of Topographical, Property and Utility DGN plan file deliverables.  

The standard GDOT XIN file is named GDOT_Standard V8i_SS2.xin and is included in the 

InRoadsALL.exe download.    

After downloading and executing the InRoadsALL.exe – a Standards folder is created directly 

under the C:\InRoads Data folder. The Surveyor/SDE will copy this Standards folder to the 

Project Folder:  (See Example in Table 2.13). 

 

Table 2.13 

Name and Location of the GDOT Standard XIN File 

 

GDOT Standard XIN File C:\InRoadsData\1234567\SDE\Standards\GDOT_Standard V8i_SS2.xin  

 

 

 NOTE: The XIN file contains Named Symbology and Feature Styles which correspond with 

the ByLevel Settings in MicroStation. Please note that if any modifications or additional 

Feature Styles/Named Symbology are added by the user to the XIN – the MicroStation 

Levels may not view with the correct Symbology for those modified Feature Styles. It is 

advisable to NOT add additional Named Symbology or Styles in order for the XIN file to be 

consistent with the current MicroStation Bylevel settings so that utilities for Plans 

Productions will function correctly. 
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2.6.1 Standard Preference File (XIN) Details 

The XIN File contains the GDOT configuration settings for use in Design/Survey. These 

settings contain the current GDOT standards for plan development and processing of 

Design/Survey Data. Following are some of the Configuration Settings contained in the XIN: 

 

 Named Symbology – This controls how elements such as points, lines, text, etc. 

appear in plan, cross section and profile views in MicroStation. The GDOT named 

symbology is also set to ByLevel which references the Level Settings for Symbology 

in the MicroStation DGNLIB. ByLevel controls the Symbology (weight, color, 

linestyle) and the Named Level on which the elements are located. The Named 

Symbology can also be set in the InRoads Named Symbology Manager by selecting 

each symbology (color, weight, linestyle, etc.) separately but GDOT uses the 

ByLevel Symbology to correspond with the DGNLIB Levels.  (The Named 

Symbology determines “How” an element is viewed”).  

 

 Feature Styles – InRoads contains Features which represent elements such as points, 

lines, arcs, spirals, etc. The Feature Style for each Geometry, Survey, DTM and 

Component element is used to determine how the elements view. The elements can 

be set to view in plan view, profile, cross section, DTM, etc. The Feature Style 

references the associated Named Symbology to view the element with the 

appropriate corresponding Symbology.  The Feature Style determines “Where” the 

element is viewed. 

  

  Preferences – When using commands in the InRoads dialog boxes – it is useful to 

set Preferences which can be loaded later without having to re-enter information into 

the dialog boxes. Preferences are basically entries in dialog boxes which can be saved 

and then selected to automatically configure the settings of a dialog box without 

manual re-entry. 

 

 Filters – Filters are commands in dialog boxes which can be used to “filter” 

selections of data based on set criteria. This can include selection of Points, 

Alignments, Features or other entities by using a filter based on the entities’ Style, 

Name, etc.   

 

These are some of the GDOT standards that have been configured for use in the XIN file. 

These settings are used to assist in the Survey/Design process to ensure that standards are 

consistent for development of GDOT project plans. 
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2.6.2 GDOT Preferences 

As mentioned previously - Preferences are entries in dialog boxes which can be saved and then selected later to automatically 

configure the settings of a dialog box without manual re-entry.  The following Table lists the GDOT Preferences available in the 

GDOT XIN file. These Preferences are discussed in more detail in each of the applicable Sections of the Survey and Design 

Guidelines. 

 

 

Preference Name 
Dialog 
Name 

Dialog Location Description 

10 Scale Work Sec 1x Vert  Exg 
(Ensure the “Create Cross Section 
Folder”  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

X-Section Grid (10 Scale) for Earthwork and End-Area reports.  For 
use on projects with small footprints.  Most situations will require 
using the ‘50 Scale Work Sec 2x Vert Exg’ Preference. 

100h_10v Profile 
 

Annotate 
Profile 

Evaluation  Profile 
 Annotate Profile  
Preferences 

Sets settings for 100’ Scale Horizontal and 10’ Scale Vertical viewing 
of existing and proposed Profile elevations on the Profile plan 
sheets. Use when annotating Profiles for Profile sheets using the ‘50 
Scale Single Profile’ Preference in the Plan and Profile Generator. 

100h_10v_SHEETS Create 
Profile 
 
 
 
Annotate 
Profile 
 
 

Evaluation  Profile 
 Create Profile  
Preferences 
 
 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 100’ Horizontal Scale and 10’ Vertical Scale.  This 
Preference is also referenced in the Plan & Profile Generator when 
generating 50 Scale Single Profile Sheets. 
 
This same preference name is now also used in the Annotate Profile 
dialog box.  It was copied from and is identical to the 100h_10v 
Profile preference.  This is so the ‘Profile Preference’ under the 
‘Profile Controls’ tab of the ‘Plan and Profile Generate’ dialog will 
not display Superelevation diagrams on the profile sheets. 

100h_10v_WORKING Create 
Profile 

Evaluation  Profile 
 Create Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 100’ Horizontal Scale and 10’ Vertical Scale.  
Same as 100h_10v_SHEETS except grid is not drawn.  For use during 
temporary viewing of Profile during vertical alignment design. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

20 Scale Survey 
Options 

Survey ► Fieldbook 
Data ► Survey 
Options  
Preferences 

Sets Cell Scale, Text Scale, and Line Scale for viewing survey 
planimetrics for 20 Scale projects. 

20 Scale Double Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 20 Scale Double Profile Sheets. 
 
 
 

20 Scale Plan  Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

To be developed. 

20 Scale Plan & Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 20 Scale Plan & Profile Sheets. 

20 Scale Single Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 20 Scale Single Profile Sheets.  
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

20h_5v Profile   Annotate 
Profile 

Evaluation  Profile 
 Annotate Profile  
Preferences 

Sets settings for 20’ Scale Horizontal and 5’ Scale Vertical viewing of 
existing and proposed Profile elevations on the Profile plan sheets.  
Use when annotating Profile for Profile sheets using the ‘20 Scale 
Single Profile’, ’20 Scale Double Profile, and ’20 Scale Plan & Profile’ 
Preferences in the Plan and Profile Generator. 

20h_5v_SHEETS Create 
Profile 
 
 
 
 
Annotate 
Profile 
 
 

Evaluation  Profile 
 Create Profile  
Preferences 
 
 
 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 20’ Horizontal Scale and 5’ Vertical Scale.  This 
Preference is also referenced in the Plan & Profile Generator when 
generating 20 Scale Single Profile Sheets, 20 Scale Double Profile 
Sheets and 20 Scale Plan and Profile Sheets. 
 
This same preference name is now also used in the Annotate Profile 
dialog box.  It was copied from and is identical to the 20h_5v Profile 
preference.  This is so the ‘Profile Preference’ under the ‘Profile 
Controls’ tab of the ‘Plan and Profile Generate’ dialog will not display 
Superelevation diagrams on the profile sheets. 

20h_5v_WORKING Create 
Profile 

Evaluation  Profile 
 Create Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 20’ Horizontal Scale and 5’ Vertical Scale.  Same 
as the 20h_5v_SHEETS Preference except the grid is not drawn.  For 
use during temporary viewing of Profile during vertical alignment 
design. 

50 Scale Survey 
Options 

Survey ► Fieldbook 
Data ►Survey 
Options 
►Preferences 

Sets Cell Scale, Text Scale, and Line Scale for viewing survey 
planimetrics for 50 Scale projects. 
 
 

50 Scale Double Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 
 

Used for generating 50 Scale Double Profile Sheets. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

50 Scale Plan  Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

To be developed. 

50 Scale Plan & Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 50 Scale Plan & Profile Sheets. 

50 Scale Single Profile Plan and 
Profile 
Generator 

Drafting  Plan and 
Profile Generator  
Preferences 

Used for generating 50 Scale Single Profile Sheets.   

50 Scale Work Sec 2x Vert Exg Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

X-Section Grid (50 Scale) for Earthwork and End-Area reports.  Most 
situations will require using this Preference. 

50h_10v Profile Annotate 
Profile 

Evaluation  Profile 
 Annotate Profile  
Preferences 

Sets settings for 50’ Scale Horizontal and 10’ Scale Vertical viewing of 
existing and proposed Profile elevations on the Profile plan sheets.  
Use when annotating Profile for Profile sheets using the ’50 Scale 
Double Profile’, and ’50 Scale Plan & Profile’ Preferences in the Plan 
and Profile Generator. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

50h_10v_SHEETS Create 
Profile 
 
 
 
 
Annotate 
Profile 
 

Evaluation  Profile 
 Create Profile  
Preferences 
 
 
 
Evaluation  Profile 
 Annotate Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 50’ Horizontal Scale and 10’ Vertical Scale.  This 
Preference is also referenced in the Plan & Profile Generator when 
generating 50 Scale Double Profile Sheets and 50 Scale Plan and 
Profile Sheets. 
 
This same preference name is now also used in the Annotate Profile 
dialog box.  It was copied from and is identical to the 20h_5v Profile 
preference.  This is so the ‘Profile Preference’ under the ‘Profile 
Controls’ tab of the ‘Plan and Profile Generate’ dialog will not display 
Superelevation diagrams on the profile sheets. 

50h_10v_WORKING Create 
Profile 

Evaluation  Profile 
 Create Profile  
Preferences 

Loads grid settings, station formats, fonts and symbology for use in 
plotting a Profile at 50’ Horizontal Scale and 10’ Vertical Scale.  Same 
as the 50h_10v_SHEETS Preference except the grid is not drawn.  For 
use during temporary viewing of Profile during vertical alignment 
design. 
 

ACL View 
Stationing  
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing  
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation  
Preferences 

Loads settings for viewing Horizontal Alignment Stationing and Curve 
Data. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

ACL Cogo Point Feature Styles Geometry 
Selection 
Filter 

Geometry  View 
Geometry  
Horizontal Annotation 
► Filter ► 
Preferences 

For use by the Survey Data Engineer (SDE) when creating the ACL 
centerline alignment.  The Preference is used in the Geometry 
Selection Filter when only points with the following Feature Styles 
are desired to be viewed.   
 
PROP_E_API,PROP_E_APT,PROP_E_APC,PROP_E_APOT,PROP

_E_APOC 

 

BEARING & DISTANCE View 
Horizontal 
Annotation 

Geometry  View 
Geometry  
Horizontal Annotation 
 Preferences 

Loads settings into the View Horizontal Annotation dialog to label 
the bearing when viewing Roadway alignments with the feature 
styles MAIN_P_CONSTCL, MAIN_P_SIDECL, and PROP_E_ACL.  
Although DISTANCE is part of the Preference name the distance is no 
longer set up to be labeled.  
 
 

BOGUS SURFACE View 
Triangles /  
 
 
Surface 
Properties 

Surface  View 
Surface  Triangles  
Preferences. 
 
Surface ► Surface 
Properties ►  
Advanced 

Used for viewing surface triangles of ‘Bogus’ Surfaces (surfaces 
created by the designer for the temporary filling of obscured areas).  
The Bogus Surface Preference loads settings to view the surface as 
pink, easily distinguishing it as a Bogus Surface.  The Bogus Surface 
Preference is used in both the View Triangles dialog and the Surface 
Properties dialog.  The Surface Properties dialog ensures the pink 
surface is displayed when viewing existing ground Profiles and Cross 
Sections. 
 

Bridge Hydraulics Annotate 
Feature 

Surface  View 
Surface   Annotate 
Feature Preferences 

Loads settings into the Annotate Feature dialog to annotate selected 
Bridge Features in the Surface for use in Bridge Hydraulics. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

CONSTCL View 
Stationing/ 
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing ► 
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation► 
Preferences 

50 Scale settings for viewing Stationing and Curve Set Annotation for 
Mainline Construction Centerline Alignments. 

CONSTCL 20 SCALE View 
Stationing 
 
 

Geometry  View 
Geometry  
Stationing ► 
Preferences 

20 Scale settings for viewing Stationing of Mainline Construction 
Centerline Alignments. 

Default  Default Preference Original Equipment Manufacturers default settings. 
 
 

Design Default Project 
Options 

File ► Project Options 
► Preferences 

For use by Design.  Loads proper point numbering and prefixes, 
precision, abbreviations, sight distance settings, factors, tolerances 
Units and formats for GDOT projects. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

DETCL View 
Stationing/ 
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing ► 
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation ► 
Preferences 

50 Scale settings for viewing Stationing and Curve Set Annotation for 
Detour Centerline Alignments. 

DETCL 20 Scale View 
Stationing 
 
 

Geometry  View 
Geometry  
Stationing ► 
Preferences 

20 Scale settings for viewing Stationing for Detour Centerline 
Alignments. 
 
 
 

Ditch Flow Arrows Annotate 
Feature 

Surface  View 
Surface   Annotate 
Feature Preferences 

Loads settings into the Annotate Feature dialog to place the ‘Ditch 
Flow Arrow’ cell on user selected features.  The settings ensure the 
‘Ditch Flow Arrow’ cell point in the direction of flow. 

ENHANCEMENTS View 
Triangles 

Surface  View 
Surface  Triangles  
Preferences 

For use by the SDE when viewing enhancements to obscured areas 
for inclusion into the Existing DTM. 

EXISTING View 
Triangles/ 
 
 
View 
Contours 

Surface  View 
Surface  Triangles  
Preferences 
 
Surface  View 
Surface  Contours  
Preferences 

For use when viewing the Existing DTM. 

Existing Majors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 

Preferences  

For use in labeling individual Major Contour Elevations of Existing 
ground surfaces. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

Existing Minors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 

Preferences 

For use in labeling individual Minor Contour elevations of Existing 
ground surfaces. 

FINISH View 
Triangles/ 
 
 
View 
Contours 

Surface  View 
Surface  Triangles  
Preferences 
 
Surface  View 
Surface  Contours  
Preferences 

For use when viewing Final DTM Surfaces. 

Finished Majors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 

Preferences 

For use in labeling individual Major Contour Elevations of Finished 
Design Surfaces. 

Finished Minors Label 
Contours 

Surface ► View 
Surface ► Label 
Contours ► 

Preferences 

For use in labeling individual Minor Contour Elevations of Finished 
Design Surfaces. 

GDOT Display 
Template 

Modeler ► Create 
Template ►Right 
mouse click over the 
Template to Display 
and select Display ► 
Preferences 

Loads settings for viewing a component or template in MicroStation. 

GDOT Earthwork Volumes 
(Ensure the “End-Area Volumes” 
folder  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Loads settings for generating the GDOT Earthwork Volumes Report. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

GDOT Profiles   View 
Vertical 
Annotation 

Geometry ► View 
Geometry ► Vertical 
Annotation 

Settings for proper viewing of vertical curve data on the Profile Plan 
Sheets.  

Narrow 10h 10v 
(Ensure the “Create Cross Section” 
folder  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Loads settings for creating Narrow Cross Section Sheets at a 10 
Horizontal to 10 Vertical Scale.  The Global Scale Factor must be set 
separately to 10.0000 for proper viewing. 

NO BEARING & DISTANCE View 
Horizontal 
Annotation 

Geometry  View 
Geometry  
Horizontal Annotation 
 Preferences 

Loads settings into the View Horizontal Annotation dialog to turn off 
labeling the bearing and distance when viewing alignments. 

OEM_Default  Surface  View 
Surface  Triangles  
Preferences 

Original Equipment Manufacturers default settings. 
 
 
 
 

PAR NAMES View 
Closed 
Areas 

GeometryView 
GeometryClosed 
Areas Preferences 

Loads settings for viewing the Alignment Names of closed Alignments 
in the MicroStation DGN. 

Prop.dgn Alignments Geometry 
Selection 
Filter 

Geometry  View 
Geometry  
Horizontal Annotation 
 Filter ►Preferences 

For use by the SDE when creating the PI#_PROP.dgn file for delivery 
to the Design Office.  The Preference filters the Feature Styles to the 
13 Features Styles listed here:   
 
PROP_E_ACL,PROP_E_BCOL,PROP_E_BCTL,PROP_E_BGMD, 

PROP_E_BLDL,PROP_E_BLLL,PROP_E_BMISC,PROP_E_BSL, 

PROP_E_PAR,PROP_E_POEL,PROP_E_RWE,PROP_E_RWRR, 

PROP_E_RWU 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

Prop.dgn Points Geometry 
Selection 
Filter 

Geometry  View 
Geometry   
Horizontal Annotation 
 Filter ►Preferences 

For use by the SDE when creating the PI#_PROP.dgn file for delivery 
to the Design Office.  The Preference filters the Feature Styles to the 
22 Features Styles listed here:   
 
PROP_E_APC,PROP_E_API,PROP_E_APOC,PROP_E_APOT, 

PROP_E_APT,PROP_E_BCOL,PROP_E_BCTL,PROP_E_BGMD,

PROP_E_BLDL,PROP_E_BLLL,PROP_E_BMISC,PROP_E_BSL, 

PROP_E_PAR,PROP_E_PCF,PROP_E_POEL,PROP_E_PPC, 

PROP_E_PPOL,PROP_E_RWC,PROP_E_RWE,PROP_E_RWM, 

PROP_E_RWRR,PROP_E_RWU 

 

REQD.dgn Alignments Geometry 
Selection 
Filter 

Geometry  View 
Geometry   
Horizontal Annotation 
 Filter ►Preferences 

For use in creating the PI#REQD.dgn file.  The Preference filters the 
Feature Styles to the 4 Features Styles listed here:   
 
REQD_P_DWESMT,REQD_P_PESMT,REQD_P_REQD,REQD_P_

TESMT 

 

REQD.dgn Points Geometry 
Selection 
Filter 

Geometry  View 
Geometry   
Horizontal Annotation 
 Filter ►Preferences 

For use in creating the PI#REQD.dgn file.  The Preference filters the 
Feature Styles to the 5 Features Styles listed here:   
 
REQD_P_DWESMT,REQD_P_PESMT,REQD_P_REQD,REQD_P_

TESMT,REQD_P_RWRM 

 

SE LEFT Display 
Super-
elevation 
in Plan 

Drafting► Display 
Superelevation in 
Plan►Preferences 

For use in displaying the Transition Stations and Superelevation Rate 
for a developed Corridor and Superelevation Control Line. SE Left 
displays information to the left of the Pivot Line defined in the 
command. 

SE RIGHT Display 
Super-
elevation 
in Plan 

Drafting► Display 
Superelevation in 
Plan►Preferences 

For use in displaying the Transition Stations and Superelevation Rate 
for a developed Corridor and Superelevation Control Line. SE Right 
displays information to the right of the Pivot Line defined in the 
command. 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

SIDECL View 
Stationing/ 
 
 
 
Curve Set 
Annotation 

Geometry  View 
Geometry  
Stationing ► 
Preferences 
 
Geometry  View 
Geometry  Curve Set 
Annotation ► 
Preferences 

50 Scale settings for viewing Stationing and Curve Set Annotation for 
Side Road Construction Centerline Alignments. 

SIDECL 20 SCALE View 
Stationing 

Geometry  View 
Geometry  
Stationing ► 
Preferences 

20 Scale settings for viewing Stationing for Side Road Construction 
Centerline Alignments. 

Stakeout Survey Data Geometry 
Selection 
Filter 

Tools ► XML Reports 
► Point Validation ► 
Filter ► Preferences 

Used to create the Stakeout Report.  The Preference filters the 
Feature Styles to the following 20 Feature Styles. 
 
PROP_E_PAR,PROP_E_RWE,PROP_E_RWM,PROP_E_RWC, 

PROP_E_RWU,PROP_E_POEL,PROP_E_PPC,PROP_E_PCF, 

TOPO_E_SNGSCM,TOPO_E_SLCM,TOPO_E_SLCD, 

TOPO_E_SDCD,TOPO_E_SBNCHMK,REQD_P_*, 

MAIN_P_CONSTCL,MAIN_P_SIDECL 

 

Surface Check MPCKGRD Geometry 
Selection 
Filter 

Tools ► XML Reports 
► Surface Check ► 
Filter ► Preferences 

Used by the District Survey Party Chiefs and the Consultant 
Compliance Supervisor in the Office of Design Policy and 
Support/Location Bureau to generate a GDOT Surface Check Report.   
The Surface Check MPCKGRD Preference is used to filter the Feature 
Styles for the First Check Points - Include: field to include only the 
Feature Style: 
 
TOPO_E_MPCKGRD 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

Surface Check MPCKPAV Geometry 
Selection 
Filter 

Tools ► XML Reports 
► Surface Check ► 
Filter ► Preferences 

Used by the District Survey Party Chiefs and the Consultant 
Compliance Supervisor in the Office of Design Policy and 
Support/Location Bureau and Support to generate a GDOT Surface 
Check Report.   The Surface Check MPCKPAV Preference is used to 
filter Feature Styles for the Second Check Points - Include: field to 
include only the Feature Style: 
 
TOPO_E_MPCKPAV 

Survey Default Project 
Options 

File ► Project Options 
► Preferences 

For use by Photogrammetry and Survey.  Loads proper point 
numbering and prefixes, precision, abbreviations, sight distance 
settings, factors, tolerances Units and formats for GDOT projects. 

SUE Annotate 
Feature in 
Profile 

Evaluation ► Profile 
► Annotate Feature 
In Profile ► 

Preferences 

Used for the profile annotation of SUE QL-A Test Hole data. 

Vertical Gore Design Tool Vertical 
Gore Tool 

Modeler► Roadway 
Designer ► Tools ► 
Vertical Gore Tool► 
Preferences 

Loads the ‘Gore’ Feature Styles into the proper fields for use in the 
Roadway Designer Vertical Gore Design Tool. 

Wide 10h 10v 
(Ensure the “Create Cross Section” 
folder  is selected) 

Cross  
Sections 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Loads settings for creating Wide Cross Section sheets at a 10 
Horizontal to 10 Vertical Scale.  The Global Scale Factor must be set 
separately to 10.0000 for proper viewing. 

XSEC TEXT – CL. EL. GROUND 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for annotating the existing ground elevation on the Cross 
Sections at the centerline alignment. 

XSEC TEXT – EL.  DIAGONAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of proposed elevations in which the text must 
be viewed diagonally. (i.e. Roadway Profile.) 
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Preference Name 
Dialog 
Name 

Dialog Location 
 

Description 
 

XSEC TEXT – EL. HORIZONTAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of proposed elevations in which the text must 
be viewed horizontally.  (i.e. Roadway Ditches.) 
 
 

XSEC TEXT – EL. VERTICAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences  
 

Used for the annotation of proposed elevations in which the text must 
be viewed vertically. 
 

XSEC TEXT – OFFSET 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

User for the annotation of offset distances as measured from the 
centerline.  (i.e. Slopestakes/Construction Limits.) 
 
 
 

XSEC TEXT – OFFSET/EL. VERTICAL 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of offset distances as measured from the 
centerline.  The elevation at the offset is also placed.  This form of 
annotation is not required on the final Cross Section plans.  It is 
provided to be used ‘as desired’ during the design process. 

XSEC TEXT – SLOPES % 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of slopes that require a percentage be used 
rather than a ratio (i.e. Pavement Cross Slopes). 
 

XSEC TEXT – SLOPES x:y 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the annotation of slopes that require a ratio be used rather 
than a percentage (i.e. Ditch Slopes, Front Slopes, Back Slopes, etc.). 
 

XSEC TEXT – SUE 
(Ensure the “Annotate Cross 
Section” folder  is selected) 

Annotate 
Cross 
Section 

Evaluation  Cross 
Section  Cross 
Sections  
Preferences 

Used for the cross section annotation of SUE QL-A Test Hole data. 
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2.7 GDOT Standard InRoads Photogrammetric Feature Codes 
The following table contains the standard Photogrammetry Codes and the associated InRoads 

Alpha Codes for use in Photogrammetry.  
 

GDOT STANDARD PHOTOGRAMMETRY CODES 

K 
 Code 

Description         
 InRoads 

Alpha Code            
Triangulate 

(Yes/No)             

K5 EDGE OF ASPHALT PAVEMENT TEAP Y 

K5 EDGE OF ASPHALT DRIVE TEAD Y 

K6 EDGE OF ASPHALT SHOULDER TEAS Y 

K7 EDGE OF TRAVEL LANE TETL  Y 

K8 WHITE LINE STRIPING TSTP Y 

K9 EDGE OF DIRT ROAD TEDR Y 

K9A EDGE OF DIRT DRIVE TEDD Y 

K17 SIDEWALK, EDGE TSW  Y 

K19A FOUNDATION FNDN N 

K19B RUINS RUIN  Y 

K28 DAM, TOP DDT Y 

K36 EDGE OF CONCRETE DRIVE TECD  Y 

K41 SWIMMING POOL POOL  N 

K43 DITCH FLOW LINE MDITCHFL Y 

K44 EDGE OF RIVER TRIVER  Y 

K45 EDGE OF LAKE TLAKE Y 

K63 PAVED DITCH DPD  Y 

K150 JOB LIMIT LINE MJLL  N 

K152 EMERGENCY LANE TEL  Y 

K154 CURB & GUTTER, TOP TCGT  Y 

K155 CURB & GUTTER, F/L TCGF Y 

K156 CROWN OF ROAD TCOR Y 

K157 MAP SEW LINE MSEWLINE N 

K158 RANDOM TERRAIN POINT TRP Y 

K159 MAP OBSCURE AREA MOBSC Y 

K161 RAILROAD, TOP OF RAIL TRCRE Y 

K163 WALL TOP, 3D TWFT Y 

K164 WALL BOTTOM, 3D TWFB Y 

K165 TERRAIN POINT ON BREAK LINE TPBL Y 

K166 CONSTRUCTION BOUNDARY, ACTV TCBA Y 

K167 DAM, TOE DADB Y 
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2.8 GDOT Standard InRoads Field Survey Feature Codes 
The following spreadsheet is for informational use only so that the Designer and SDE will have a reference for the Field Survey Feature 

Codes if needed. The spreadsheet contains the standard Numeric SMI Codes and the associated InRoads Alpha Codes for use in 

Field Survey. The InRoads Feature Style is depicted for use by Survey Data Engineers and Designers. The Point Type and Chain 

Type Triangulate (Yes/No) column(s) are for informational use only. This column denotes the status of the Alpha Code and lists 

whether it is triangulated or not triangulated in the DTM Surface and whether it is a Point Type or a Chain Type.    

 
   

SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

 Ground Elevations          

1 TERRAIN POINT ON BREAK LINE TPBL TOPO_E_TPBL  Y 4 

2 RANDOM TERRAIN POINT TRP TOPO_E_TRP Y  2 

  Property and Right-of-Way       

3 RIGHT-OF-WAY MARKER FOUND RWM PROP_E_RWM N  1 

4 RIGHT-OF-WAY POINT COMPUTED RWC PROP_E_RWC N  1 

5 RIGHT-OF-WAY UTILITY COMPANY RWU PROP_E_RWU N  1 

6 RIGHT-OF-WAY PRESCRIPTION PT RWE PROP_E_RWE  N 3 

7 POINT ON EASEMENT LINE POEL PROP_E_POEL N  1 

8 PROPERTY CORNER FOUND PCF PROP_E_PCF N  1 

9 PROPERTY POINT ON LINE PPOL PROP_E_PPOL N  1 

10 PROPERTY POINT COMPUTED PPC PROP_E_PPC N  1 

  Alignment       

15 POINT ON TANGENT, EXISTING APOT PROP_E_APOT N  1 

16 POINT OF CURVATURE, EXISTING APC PROP_E_APC N  1 

17 POINT ON CURVE, EXISTING APOC PROP_E_APOC N  1 

18 POINT OF TANGENCY, EXISTING APT PROP_E_APT N  1 

19 POINT OF INTERSECTION API PROP_E_API N  1 

20 ALIGNMENT CENTERLINE ACL  PROP_E_ACL  N 3 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

  Roadways   
 

      

24 EDGE OF DIRT ROAD TEDR TOPO_E_TEDR  Y 4 

25 EDGE OF ASPHALT DRIVE TEAD TOPO_E_TEAD  Y 4 

26 EDGE OF CONCRETE DRIVE TECD TOPO_E_TECD  Y 4 

27 EDGE OF ASPHALT PAVEMENT TEAP TOPO_E_TEAP  Y 4 

28 EDGE OF ASPHALT SHOULDER TEAS TOPO_E_TEAS  Y 4 

29 EDGE OF CONCRETE PAVEMENT TECP TOPO_E_TECP  Y 4 

30 EDGE SURFACE TREATMENT ROAD TEST TOPO_E_TEST  Y 4 

31 CURB, ASPHALT TAC TOPO_E_TAC  Y 4 

32 CURB, HEADER THC TOPO_E_THC  Y 4 

33 CURB & GUTTER, TOP TCGT TOPO_E_TCGT  Y 4 

34 CURB & GUTTER, F/L TCGF TOPO_E_TCGF  Y 4 

35 V-GUTTER TVG TOPO_E_TVG  Y 4 

36 BRIDGE APPROACH SLAB, EDGE TBAS TOPO_E_TBAS  Y 4 

37 BRIDGE END, CENTER TBRDGCEN TOPO_E_TBRDGCEN  N 4 

38 BRIDGE OUTSIDE EDGE/CORNER TBRDGCOR TOPO_E_TBRDGCOR  N 4 

39 BRIDGE COLUMN, CENTER TCOLC TOPO_E_TCOLC N  1 

40 BRIDGE COLUMN, EDGE TCOLE TOPO_E_TCOLE N  1 

41 BRIDGE GUTTER/SIDEWALK/CURB EDGE TBGL TOPO_E_TBGL  N 4 

42 BRIDGE CENTERLINE TBCL TOPO_E_TBCL  N 4 

43 ENDROLL TENDROLL TOPO_E_TENDROLL  Y 4 

44 BRIDGE CAP TBCAP TOPO_E_TBCAP N  2 

154 EDGE OF DIRT DRIVE TEDD TOPO_E_TEDD  Y 4 

NA EDGE OF TRAVEL LANE TETL TOPO_E_TETL                                            Y 4 

210 SIDEWALK, EDGE TSW TOPO_E_TSW  Y 4 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

  Drainage   
 

      

45 SINGLE CATCH BASIN, GUTTER F/L DCB TOPO_E_DCB N  2 

47 DOUBLE CATCH BASIN, GUTTER F/L DDCB TOPO_E_DDCB N  2 

49 DROP INLET, TOP DDI TOPO_E_DDI N  2 

50 SPUR DIKE DSPURDK TOPO_E_DSPURDK  Y 4 

51 TOP OF WATER ELEVATION DWE TOPO_E_DWE N  2 

52 STREAM CENTER, F/L DSC TOPO_E_DSC  Y 4 

53 STREAM EDGE DSE TOPO_E_DSE  Y 4 

54 STREAM BANK TOP DSB TOPO_E_DSB  Y 4 

55 DAM, TOP DDT TOPO_E_DDT  Y 4 

56 DAM, TOE DADB TOPO_E_DADB  Y 4 

57 OBSCURED AREA DOBSC TOPO_E_DOBSC  Y 4 

59 HEAD WALL, END DHWE TOPO_E_DHWE  N 3 

60 CULVERT, WINGWALL END DCWE TOPO_E_DCWE  N 3 

62 SWAMP EDGE DSWE TOPO_E_DSWE  N 3 

63 WETLAND BOUNDARY DWB TOPO_E_DWB  N 3 

NA  STREAM BANK-FULL SBF TOPO_E_SBF N  2 

NA STREAM X-SECTION SXS TOPO_E_SXS N  2 

NA DRAINAGE BOTTOM OF DITCH DBOD TOPO_E_DBOD  Y 4 

NA DRAINAGE TOP OF DITCH DTOD TOPO_E_DTOD  Y 4 

152 HIGH WATER MARK  DHWM            TOPO_E_DHWM N  2 

164 PAVED DITCH  DPD TOPO_E_DPD  Y 4 

166 SEPTIC TANK CENTER DSTC                             TOPO_E_DSTC                             N  1 

170 DRAIN LINES  DDL TOPO_E_DDL  N 3 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

  Utilities   
 

      

68 STRAIN POLE UUSTRPOL UTLE _E_UUSTRPOL N  1 

69 ELECTRICAL BOX UUELBOX UTLE _E_UUELBOX  N 3 

70 OVERHEAD ELECTRICAL LINE UUOEL UTLE _E_UUOEL  N 3 

71 OVERHEAD TELEPHONE LINE UUOTL UTLE _E_UUOTL  N 3 

72 POWER POLE, CENTER UUPP UTLE _E_UUPP N  1 

73 LIGHT POLE, CENTER UULP UTLE _E_UULP N  1 

74 TELEPHONE POLE, CENTER UUTP UTLE _E_UUTP N  1 

75 TELEPHONE PEDESTAL, CENTER UUTPD UTLE _E_UUTPD N  1 

76 GUY POLE, CENTER UUGP UTLE _E_UUGP N  1 

77 POLE ANCHOR UUPGA UTLE _E_UUPGA N  1 

78 YARD LIGHT, ELECTRICAL UUYLE UTLE _E_UUYLE N  1 

79 YARD LIGHT, GAS UUYLG UTLE _E_UUYLG N  1 

80 WATER METER, CENTER UUWM UTLE _E_UUWM N  1 

81 WATER VALVE UUWV UTLE _E_UUWV N  1 

82 FIRE HYDRANT, CENTER UUFH UTLE _E_UUFH N  1 

83 MANHOLE STORM SEWER, TOP UUMHST UTLE _E_UUMHST N  2 

84 MANHOLE STORM SEWER, F/L UUMHSTF UTLE _E_UMHSTF N  2 

85 MANHOLE, TELEPHONE, TOP UUMHT UTLE _E_UUMHT N  2 

86 MANHOLE, ELECTRICAL, TOP UUMHE UTLE _E_UUMHE N  2 

87 MANHOLE, SANITARY SEWER, TOP UUMHSS UTLE _E_UUMHSS N  2 

88 MANHOLE, SANITARY SEWER, F/L UUMHSSF UTLE _E_UUMHSSF N  2 

89 SANITARY SEWER LINE, CENTER UUSSL UTLE _E_UUSSL N  1 

90 GAS METER, CENTER UUGM UTLE _E_UUGM N  1 

91 GAS VALVE, CENTER UUNGV UTLE _E_UUNGV N  1 

92 GAS VENT PIPE UUNGVP UTLE_E_UUNGVP N  1 

93 GAS LINE MARKER UUNGLM UTLE_E_UUNGLM N  1 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

  Utilities   
 

      

120 RAILROAD, TOP OF RAIL UTRCR UTLE_E_UTRCR  N 4 

121 RAILROAD, CENTERLINE UTRCL UTLE_E_UTRCL  N 3 

126 SATELLITE DISH UTSATDSH UTLE_E_UTSATDSH N  1 

NA PEDESTRIAN CROSS LIGHT UUPCL UTLE_E_UUPCL                                           N  1 

NA TRAFFIC SIGNAL BOX UUTSB UTLE_E_UUTSB                                            N 3 

NA UNDERGROUND FIBER MARKER UUFM UTLE_E_UUFM                                          N  1 

  Subsurface Utilities   
 

    

NA SUBSURFACE UTILITY - BOTTOM SUEBOT UTLE_E_SUEBOT                                          N  2 

NA SUBSURFACE UTILITY - TOP SUETOP UTLE_E_SUETOP                                          N  2 

  General Topo   
 

    

95 WALL TOP, 2D TWF TOPO_E_TWF  N 3 

96 WALL TOP, 3D TWFT TOPO_E_TWFT  Y 4 

97 WALL BOTTOM, 3D TWFB TOPO_E_TWFB  Y 4 

98 IRRIGATION PIVOT POINT TIRRPVTP TOPO_E_TIRRPVTP N  1 

99 IRRIGATION LIMITS TIRRLMT TOPO_E_TIRRLMT N  1 

100 SIGN, CENTER TSC TOPO_E_TSC N  1 

101 GASOLINE MONITORING WELL TGMW TOPO_E_TGMW N  1 

102 GASOLINE FILLER VALVE TGFV TOPO_E_TGFV N  1 

103 GASOLINE VENT PIPE TGVP TOPO_E_TGVP N  1 

104 GASOLINE PUMP TGP TOPO_E_TGP N  1 

105 GASOLINE STORAGE TANK, END TGST TOPO_E_TGST  N 3 

106 GASOLINE PUMP ISLAND TGPI TOPO_E_TGPI  N 3 

107 CANOPY TCAN TOPO_E_TCAN  N 3 

108 BUILDING CORNER TBLD TOPO_E_TBLD  N 3 

109 BUILDING ROOF LINE CORNER TBLDRL TOPO_E_TBLDRL  N 3 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

110 HOUSE CORNER THCR TOPO_E_THCR  N 3 

111 HOUSE ROOF LINE CORNER THRL TOPO_E_THRL  N 3 

112 MOBILE HOME CORNER TMHCR TOPO_E_TMHCR  N 3 

113 MOBILE HOME ROOF LINE CORNER TMHRL TOPO_E_TMHRL  N 3 

115 WOODS LINE TWL TOPO_E_TWL  N 3 

116 CULTIVATION LINE TCUL TOPO_E_TCUL  N 3 

117 FENCE, FIELD WIRE TFFW TOPO_E_TFFW  N 3 

118 FENCE, BARB WIRE TFBW TOPO_E_TFBW  N 3 

119 FENCE, WOOD TFW TOPO_E_TFW  N 3 

122 CEMETERY LINE TCEM TOPO_E_TCEM  N 3 

123 GRAVE TGRV TOPO_E_TGRV  N 3 

124 GUARDRAIL TGR TOPO_E_TGR  N 3 

125 SIGN, END TSE TOPO_E_TSE  N 3 

127 LIMIT LINE TLIML TOPO_E_TLIML  Y 4 

128 CONSTRUCTION BOUNDARY, ACTV TCBA TOPO_E_TCBA  Y 4 

129 CONSTRUCTION BOUNDARY, FIND TCBF TOPO_E_TCBF  Y 4 

153 FLOOR ELEVATION  TFE TOPO_E_TFE N  2 

156 GATE  TG TOPO_E_TG  N 3 

158 UNCOVERED DECK TUD TOPO_E_TUD  N 3 

162 VINYL (PVC) FENCE  TVF TOPO_E_TVF  N 3 

163 FUEL TANK        TFT TOPO_E_TFT  N 3 

165 BRICK COLUMN TBC TOPO_E_TBC  N 3 

167 STEPS                                                                                                   TS  TOPO_E_TS   N 3 

168 HISTORICAL MONUMENT                          THM TOPO_E_THM  N 3 

169 FLAG POLE  TFP TOPO_E_TFP N  1 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

  Boundaries   
 

    

130 COUNTY LINE BCOL PROP_E_BCOL  N 3 

131 CITY LIMIT LINE BCTL PROP_E_BCTL  N 3 

132 LAND DISTRICT LINE BLDL PROP_E_BLDL  N 3 

133 LAND LOT LINE BLLL PROP_E_BLLL  N 3 

134 STATE LINE BSL PROP_E_BSL  N 3 

135 GEORGIA MILITIA DISTRICT LINE BGMD PROP_E_BGMD  N 3 

  ****Surface Checks        

160 ****MAP CHECK GROUND MPCKGRD TOPO_E_MPCKGRD N  2 

161 ****MAP CHECK PAVEMENT MPCKPAV TOPO_E_MPCKPAV N  2 

  Surveyor Defined 
 

       

171 Surveyor Defined Value XXA TOPO_E_XXA  Y 4 

172 Surveyor Defined Value XXB TOPO_E_XXB  Y 4 

173 Surveyor Defined Value XXC TOPO_E_XXC  Y    4 

174 Surveyor Defined Value XXD TOPO_E_XXD  Y 4 

175 Surveyor Defined Value XXE TOPO_E_XXE  Y 4 

176 Surveyor Defined Value XXF TOPO_E_XXF  Y 4 

177 Surveyor Defined Value XXG TOPO_E_XXG  Y 4 

178 Surveyor Defined Value XXH TOPO_E_XXH  N 3 

179 Surveyor Defined Value XXI TOPO_E_XXI  N 3 

180 Surveyor Defined Value XXJ TOPO_E_XXJ   N 3 

181 Surveyor Defined Value XXK TOPO_E_XXK  N 3 

182 Surveyor Defined Value XXL TOPO_E_XXL  N 3 

183 Surveyor Defined Value XXM TOPO_E_XXM  N 3 

184 Surveyor Defined Value XXN TOPO_E_XXN  N 3 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

185 Surveyor Defined Value XXO TOPO_E_XXO Y  2 

186 Surveyor Defined Value XXP TOPO_E_XXP Y  2 

187 Surveyor Defined Value XXQ TOPO_E_XXQ Y  2 

188 Surveyor Defined Value XXR TOPO_E_XXR Y  2 

189 Surveyor Defined Value XXS TOPO_E_XXS Y  2 

190 Surveyor Defined Value XXT TOPO_E_XXT Y  2 

191 Surveyor Defined Value XXU TOPO_E_XXU Y  2 

192 Surveyor Defined Value XXV TOPO_E_XXV N  1 

193 Surveyor Defined Value XXW TOPO_E_XXW N  1 

194 Surveyor Defined Value XXX TOPO_E_XXX N  1 

195 Surveyor Defined Value XXY TOPO_E_XXY N  1 

196 Surveyor Defined Value XXZ TOPO_E_XXZ N  1 

197 Surveyor Defined Value XXZA TOPO_E_XXZA N  1 

198 Surveyor Defined Value XXZB TOPO_E_XXZB N  1 

199 Surveyor Defined Value XXZC TOPO_E_XXZC N  1 

       

  Surveyor Defined Utilities 
 

        

NA Surveyor Defined Value (Utility) UXXA UTLE_E_UXXA                                           N  1 

NA Surveyor Defined Value (Utility) UXXB UTLE_E_UXXB                                            N 3 

       

  Dimension Codes: (Drainage) 
 

       

200 DRAINAGE PIPE, F/L, CONCRETE DPC TOPO_E_DPC  N 4 

201 DRAINAGE PIPE, F/L, METAL DPM TOPO_E_DPM  N 4 

202 DRAINAGE PIPE, F/L, PLASTIC DPP TOPO_E_DPP  N 4 

203 CULVERT END, F/L DCEF TOPO_E_DCEF  N 4 
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SMI 
Code 

Description 
InRoads 

Alpha        
Code 

InRoads  
Feature Style 

Point Type 
Triangulate   

(Y/N) 

Chain Type 
Triangulate 

(Y/N) 

Group 
Code 

  Dimension Codes (General Topo) 
 

     

211 FENCE, CHAIN LINK TFCL TOPO_E_TFCL  N 3 

212 TREE, CENTER TTRE TOPO_E_TTRE N  1 

213 WELL TWELL TOPO_E_TWELL N  1 

  Dimension Codes (Roadway) 
 

     

235 MILE POST, RAILROAD UTMPR UTLE _E_UTMPR N  1 

236 KM POST, HIGHWAY TKMP TOPO_E_TKMP N  1 

237 MILE POST, HIGHWAY TMPH TOPO_E_TMPH N  1 

  Survey Control 
 

     

240 NGS CONTROL MONUMENT SNGSCM TOPO_E_SNGSCM N  2 

241 LOCATION CONTROL MONUMENT SLCM TOPO_E_SLCM N  2 

242 LOCATION CONTROL DELTA SLCD TOPO_E_SLCD N  2 

243 DISTRICT CONTROL DELTA SDCD TOPO_E_SDCD N  2 

244 CONTROL RE-SHOT FOR CHECK SCCHK TOPO_E_SCCHK N  2 

245 BENCHMARK SBNCHMK TOPO_E_SBNCHMK N  2 
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***SMI Code 250 Miscellaneous MISC TOPO_E_MISC 

(Not to be used by field survey personnel.  Reserved for use by the GDOT Location Bureau for 

such items as Control work for mappers, property line disputes, consultant rechecks, etc.  Field 

survey personnel should only use the surveyor defined codes 171 to 199 for miscellaneous 

undefined items). 

 

****For use by Department ONLY. 
 

 

 

  

SMI Codes For InRoads 
 

User Defined Codes 
171-177     Group Code 4 

178-184     Group Code 3 

185-191     Group Code 2 

192-199     Group Code 1 

 

Group Codes 
Code 1     2-D Point 

Code 2     3-D Point 

Code 3     2-D Chain 

Code 4     3-D Chain 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 

 

    3. 
Surface and Property Data Information 
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3. Surface and Property Data Information 

This section provides a brief overview of the requirements for the GDOT standard DTM Surface 

and Property Data generation.   

This section covers the following topics: 

 

● DTM Surface Information 

● Property Data Information 
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3.1 DTM Surface Information 
In order to generate DTM Surfaces to GDOT standard conventions – the following Surface 

information should be adhered and followed. 

 

 

a)  The DTM Surface will contain all Surface data which is not property or 

alignment related (both triangulated and non-triangulated data). All Property 

Data, Existing Right of Way, Alignment Data, etc. will not be available in the 

DTM. The Geometry data will only be available in the Geometry Project 

(.ALG). 

 

b) Never save Surface Data to the “Default” Surface listed in the InRoads 

Explorer. Always create a new empty Surface to import the data and name the 

surface using the naming schemes depicted in the Introduction to InRoads for 

Survey Data Processing Training Guide.  See also Chapter 2 - Table 2.2 

(Standard Naming Conventions listed in this document) for the standard 

Processed DTM and Intermediate DTM naming schemes. 

 

c) The Maximum Length of Surface triangles will be 300.00 feet in order to 

correspond to current GDOT DTM standards. This setting can be entered in the 

Triangulate Surface dialog box in InRoads. 

 

d) In order to view ALL Surface Feature Data – ensure the Feature Filter Lock is 

turned OFF. To accomplish this - remove the check mark from Tools► Locks 

► Feature Filter in InRoads. In order to view filtered Surface Feature Data – 

ensure the Feature Filter Lock is turned ON. 

 

e) During the processing of survey data, situations can occur where breaklines 

may overlap or breaklines may cross at mismatched elevations. If these 

segment crossings are not resolved, erroneous point and breakline data may 

affect the triangulation and accuracy of the DTM (Digital Terrain Model). 

These crossings need to be addressed and resolved prior to the final creation 

of the DTM Surface to ensure that an accurate Surface Model is generated.  

 

f) When using the View Crossing Segments command -- crossing segment 

points are represented by a Yellow X.  Mismatched elevations are represented 

by a Red O.   There are two main types of crossing segments: overlaps and 

mismatched elevations.  

 

g) When using the InRoads Resolve Crossing Segments command, the default 

delta tolerance for elevation differences (mismatched elevations) is 0.020. 

This is considered the standard GDOT default tolerance.  Any mismatched 

elevations with a 0.020 tolerance or less are considered to be of minimum 

significance. Any mismatched elevations greater than a Delta Tolerance of 

0.020 should be manually evaluated and resolved by using the InRoads Edit 

Surface Tools. 
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h) An Exterior Boundary (a Limit Line with Feature Style of 

TOPO_E_TLIML) will be created to represent the bounds of the field data.  

This Exterior Boundary is also used in the trimming of extraneous triangles 

from the DTM Surface.  During the creation of a DTM Surface, extraneous 

triangles (erroneous triangle data) will be generated which does not represent 

actual Surface data. A common situation where this occurs is at “T 

Intersections”.  In order to remove these triangles (which represent inaccurate 

data) an Exterior Boundary is required.  

 

i) Verify that the DTM Surface contains no erroneous “Spikes” (errors in 

elevation or discontinuities of Features). 

 

j) Exterior Boundary Requirements:  

 

 InRoads has a requirement that only ONE Exterior Boundary may be 

present in a DTM Surface Project. 

 The Exterior Boundary must be one continuous complex shape. 

 Ensure that the Exterior Boundary is a closed shape entity. 

 The Existing Feature Points on the exterior Boundary must be located on 

the Existing Surface in order for the Boundary to trim triangles correctly.  

 If there are Obscured Areas on the outside of the Surface data – the Exterior 

Boundary must not include these areas inside of the Exterior Boundary. 

 Interior Obscured Areas can be included inside the Exterior Boundary. 

 Verify that all extraneous triangles are trimmed 

 

k) Exterior Boundary Naming Conventions:  

 For Mapping Projects – the Exterior Boundary Feature Name should be 

named MBOUNDARY and have the Feature Style of TOPO_E_TLIML. 

 For Full Field Survey Projects – the Exterior Boundary Feature Name 

should be named XBOUNDARY and have the Feature Style of 

TOPO_E_TLIML. 

 

l) Interior Boundary (Obscured Area) Requirements:  

 InRoads may contain numerous Interior Boundaries (Obscured Areas) in a 

DTM Project. 

 The Interior Boundary must be one continuous complex shape. 

 Verify that all Interior Boundaries are closed shape entities 

 

m) Interior Boundary Naming Conventions:  

 For Mapping Projects – the Interior Boundary Feature Name will be named 

the default name that is imported from the 3D Photogrammetric DGN file 

and have the Feature Style of TOPO_E_MOBSC. 

      For Full Field Survey Projects – the Interior Boundary Feature Name will   

     be named the default name that is imported from the CSV file and 

     have the  Feature Style of TOPO_E_DOBSC. 

 



Surface and Property Data Information InRoads Survey Data Processing Guidelines SS2 

3-5 

 

n) Review the DTM Surface to ensure that there are no erroneous or “bad” data 

included in the DTM.  This review will determine if there are any elevations 

that are incorrect or bad shots that were picked up. The DTM will be reviewed 

in a 3D environment as a “shaded model” to assist in the resolutions of any 

“spikes” or erroneous data.   

 

o) When viewing the DTM triangles and the MBOUNDARY and/or 

XBOUNDARY (the Topo Limit Line) at the same time – please be aware that 

if you use this combination and view the DTM as “Smooth” instead of 

“WireFrame” --- the Triangles will be intermixed with the color of white and 

green and will appear as a mottled color. If you view the DTM triangles in the 

“Smooth” mode – it is best NOT to view the MBOUNDARY/XBOUNDARY 

at the same time. This will allow the triangles to view as the Existing Green 

color. 

 

p) The PI#_SDE.dtm is a “working surface” for the use of Survey Data 

Engineers. After submission to the Designer(s) – the Designer will re-name the 

surface to 1234567_Exist.dtm. The procedure of re-naming the Surface will be 

the responsibility of the Designer and will be described in the Design 

Guidelines and Tutorials.  

 

q) The FWD File (Survey File) will not be submitted to the Designer. The 

information contained in this file will be merged into the Surface (DTM) or 

applicable Geometry (ALG) files and will also be represented in the 

PI#_TOPO, PI#_UTLE and PI#_PROP DGN files.  

 

r) The SDE will submit the PI#_SDE.dtm (Surface File),  PI#_SDE.alg 

(Geometry File), PI#_TOPO.dgn, PI#_UTLE.dgn and PI#_PROP.dgn files 

to the Engineering Management / Operations Manager.  These Files will 

then be submitted to the Design Engineer. 
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3.2 Property Data Information 
In order to generate and store Property Data and Existing Right of Way to GDOT standard 

conventions – the following Property information should be adhered and followed. 

 

 InRoads Property Information 
 

a) Point Prefixes shall not be utilized by the Surveyor/SDE when storing points in 

InRoads. The Surveyor/SDE shall work in the point range of 1-9999. This is to 

eliminate problems with enhancements during the life of the project.  If points 

beyond 9999 are needed, the SDE shall contact the Designer and request a 

range of points be set aside for the SDE to work in that the Designer will not 

use. 

 

b) All Alignments (for Parcels, Existing Centerlines, Existing R/W, etc.) stored in 

InRoads will have an SV Prefix pre-pended to the Alignment Name. 

 

c) Important Point Information: InRoads has different kinds of points.  

Alignment Points and COGO Points are two types of points to be aware of 

when working with alignments--- (whether it is a centerline alignment, a R/W 

alignment or a property alignment).  Alignment points are nothing more than 

names assigned to coordinates in an alignment and do not exist in the COGO 

points buffer.  In order to satisfy GDOT plan presentation requirements and 

prepare R/W tables and properly deliver enhanced survey data to the Designer 

-- Surveyors and Designers alike must ensure that all alignments have a 

corresponding COGO point stored.  Some InRoads commands only assign 

Alignment Point names and must be converted to COGO points. Some don’t 

assign alignment point names or store COGO points and must be assigned 

Alignment point names and then be converted to COGO points. As such we 

recommend that you adhere closely to the methods presented in the tutorials 

concerning centerlines, R/W and property. 

 

d) All Alignment Points must be converted to COGO Points in the InRoads 

Geometry Project. (See previous bullet above). 

 

e) Ensure that only ONE coincident COGO point is located at shared property 

corners. If this is not done - there may be issues when storing proposed Right of 

Way Alignments and creating Right of Way tables. It also reduces plan clarity. 

 

f) In InRoads all terminology for chains (whether it be Parcel Chains, 

Existing R/W Chains, or actual Existing Centerline Chains) are always 

referred to as “Alignments”.  
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 Parcel Data 
 

a) All parcels must be stored clockwise and the alignments must close (first and 

last point number must be the same).  The alignment should be a graphic 

representation of all corners of the parcel as defined in the deed or plat.  

Property corners and lines which lie within the "right-of-way take” should be 

located by field survey if possible.  If they cannot be found, their position 

should be computed from the deed or plat.  The positions of corners which do 

not lie within the "right-of-way take" can be determined by digitizing from a 

plat or tax map, or by computation. 

 

b) The alignment for the parcel must contain sufficient information 

to accurately locate all curved property lines.  The beginning and the ending 

point of each curve should be equated to a point number and those numbers 

must be included in the parcel alignment. 

 

c) The District shall provide the official area in acreage for each parcel in the 

Property Statistic Report (.XLS).  This area, which is to be taken from the 

deed or plat, is to be used by the Designer.  The area which can be computed 

from the parcel chain is not the official area and therefore is not to be used in 

design.  If acreage is not provided on the deed or plat, the District shall be 

responsible for computing this area from a legal description. 

 

d) If a parcel is split by the proposed right-of-way, or if existing access to the 

parcel is eliminated, all available access to a public roadway for the remaining 

parcel(s) should be identified by the surveyor or the Survey Data Engineer and 

a comment about this access should be added as an explanatory note in the 

Property DGN File (PI#_PROP.DGN) (i.e. "access to County Road #77" - 

shown at the appropriate place in the file). 
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e) The following information for each parcel shall be provided in a Property 

Statistic Report (.XLS) File.  The filename and location shall be provided to 

the designer.  No printout of this file should be submitted. 

 

 Land District/Section Number. 

 

 Land Lot Number. 

 

 Georgia Militia District (GMD). 

 

 Block Number. 

 

 Tax Map Number. 

 

 Tax Map Parcel Number. 

 

 Parcel Chain Number (This will be the Alignment Number for 

the parcel). 

 

 Area in acres (as recorded in the deed or plat). 

 

 Book and Page Number of where the deed is recorded. 

 

 Book and Page Number of where the Plat is recorded. 

 

 Property Owner's Name and Address. 

 

NOTE:  Parcels not described by this system will be described by the 

legal description contained in the deed. 

 

f) Explanatory notes (Parcel Alignment Number, Prescription 

R/W, Easements, etc.) should be added to the Property DGN File 

(PI#_PROP.DGN).  Additional text must have the correct attributes and level 

as indicated by the state-wide attributes and level conventions. 
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 Right-of-Way (deeded/prescriptive) and Easement 
 

a) The District shall provide all information about existing 

right-of-ways for public roadways (including railroads) located within the 

limits of the project. 

 

b) The right-of-way data shall be chained into alignments. 

 

c) The following procedures should be followed for surveying deeded Right-of-

Way: 

 

 Locate the centerline alignment of the road that was used to 

describe the deeded right-of-way coordinating at least two (2) 

points on all tangents and three (3) points on all curves.  It is 

very important to determine if any widening has taken place 

since the deed centerline was established.  If widening was not 

symmetrical, use available field evidence to establish the deed 

centerline. 

 

 All existing right-of-way markers should be coordinated. 

 

 All existing property corners which will be used to determine the 

property take will be coordinated either by field survey or by 

computation from a deed or plat.  All property points not directly 

impacting the "take" can be digitized from the deed, plat, or tax 

map. 

 

 The Property DGN File (PI#_PROP.DGN) provided by the 

District must contain a notation which states that the "right-of-

way is claimed by prescription".  
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d) The following procedures should be followed in developing the Property/Right-

of-Way database for roads with deeded right-of-way: 

 

 The alignment of the existing road should be determined by 

using the tangent and curve points from the field survey.  

Degrees of curves should be computed by using the field points, 

and then compared to old plans, and then an appropriate degree 

assigned to the curve. 

 

 The Department's right-of-way should then be set to correspond 

with this alignment. 

 

 At this point the differences between the Department's right-of-

way and the existing right-of-way markers and property 

information should be evaluated.  Major discrepancies should 

receive further investigation. 

 

 When the District creates an alignment from the field survey file, 

all corners and boundaries which conflict with the right-of-way 

should be projected or terminated to conform precisely with the 

deeded right-of-way.  

 

 The parcel alignment should contain the newly created points 

which conform to the right-of-way.  The alignment should not 

include any property points that conflict with this right-of-way.  

These conflicting points should be retained in the data file as part 

of the project records. 

 

 All existing right-of-way markers which conflict with the true 

position of the right-of-way are not to be used in any alignments 

but are to be retained in the data files as part of the project records. 
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e) The following procedures should be followed for surveying a public roadway 

that does not have a deeded right-of-way: 

 

 The surveyor will notify the Preconstruction Engineer in 

writing that the roadway does not have a deeded right-of-way. 

 

 Locate the centerline alignment of the road by coordinating at 

least two (2) points on all tangents and three (3) points on all 

curves. 

 

 Coordinate the limits of the area along the roadway which is 

maintained by the Department or by the local government (e.g., 

back of ditch to back of ditch). This area may be claimed by 

prescription if it meets the legal requirements. 

 

 The surveyor is to document on a tax map, or other drawing, all 

areas for which the Department or a local government does not 

have deeded title. 

 

 

f) The following procedures should be followed in developing the Property/Right-

of-Way database for roads with no deeded right-of-way: 

 

 The District shall create property alignments from the field 

survey file that include all property corners (field located, 

computed or digitized) which identify parcels.  

 

 The District shall create alignments from the field survey file 

that reflect the right-of-way that is considered to have been 

acquired by prescription* (possession). 

 

 The property and right-of-way alignments shall show the 

conflicts between the property lines and these limits of the 

"claimed" (prescriptive) right-of-way.   

  

 The Property DGN File (PI#_PROP.DGN) provided by the 

District must contain a notation which states that the "right-of-

way is claimed by prescription". 
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g) Easement right-of-ways for utility companies should be surveyed and chained. 

 

h) Explanatory notes should be added to the Property DGN File 

(PI#_PROP.DGN).  The text must have the correct attributes and level as 

indicated by the statewide attributes and level conventions. 

 

* Prescriptive R/W is acquired by long uninterrupted use (in GA 

usually 7 years). 

 

 

 Boundary Lines 
 

a) The District should provide the following types of boundary lines: 

 

 State 

 

 County 

 

 City 

 

 Land Lot 

 

 Public Lands 

 

 

b) The boundary lines shall be chained. 

 

c) Explanatory notes should be added to the Property DGN File 

(PI#_PROP.DGN).  The text must have the correct attributes and level as 

indicated by the statewide attributes and level conventions. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

  

 

    4. 
Survey Data Project Deliverables 
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4. Survey Data Project Deliverables 

This section provides an overview of the Survey Data Project Deliverables which will be submitted to 

the Office of Design Policy and Support/Location Bureau (Engineering Management / Operations 

Manager).  This data will then be forwarded to the Designer. 

This section covers the following topics: 

 

● Information on the Processing of Mapping and/or Full Field Survey Surface (DTM) 

● Information on the Processing of the Geometry Project (ALG ) 

● Generation of the Topographical, Property and Utility DGN File(s) 

● Listing of the SDE Project Deliverables 

 

    

 

 

 

Mapping Process Overview 
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Mapping Enhancement Process 
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Full Field Survey Process 
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4.1 Processing of the Mapping and/or Full Field Survey Surface (DTM) 
For detailed instructions regarding the generation and processing of the Survey Data and the 

creation of the DTM Surface – please refer to the “Introduction to InRoads for Survey Data 

Processing” Training Tutorial.  Detailed information for the processing of the Survey Data for 

DTM Surfaces are listed and described in Labs 1-9. 

 

Following are some Quality Assurance Verification Items to review in order to insure that an 

accurate DTM Model is created: 

 

Survey Data: 
 

 Make sure that all crossing segments and crossing overlaps are resolved 

 Ensure that there is only one Exterior Boundary 

 Verify that the Exterior Boundary Feature Style is XBOUNDARY for Full Field 

Survey and MBOUNDARY for Mapping Survey 

 Ensure that the Exterior Boundary is a closed shape entity 

 Verify that all Interior Boundaries are closed shape entities 

 Check to ensure there are no erroneous (bad) point elevations 

 Verify that Standard GDOT Naming Conventions and Feature Styles are used 

 

 

 

DTM Surface Data: 
 

 Make sure that the DTM is created using the “EXISTING” Preference 

 The Surface Properties Symbology Preference is set to “EXISTING” for both the 

Cross Sections and Profiles 

 Ensure that the Maximum Triangle Length of 300.00 is used. 

 Verify that the DTM contains no erroneous “Spikes” 

 Verify that all extraneous triangles are trimmed 

 Ensure that all MOBSC Features (obscured areas) are obscured 

 Make sure to compress the DTM Surface before submittal to the Designer 
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After the DTM Surface data has been verified and all errors corrected - the next step is the 

completion of the final processing of the DTM Surface. The DTM Surface will be re-triangulated 

and compressed (which will release memory slots that contain deleted data). The Surface Properties 

Symbology Preference will also be set to “EXISTING” for both the Cross Sections and Profiles. 

 

1. Set the Surface Properties 

The SDE will need to set the default Surface Properties before submitting the DTM.  The 

Surface Properties are settings that determine how the Existing ground will display in the 

Cross Sections and Profiles. 

  

In InRoads, Select SurfaceSurface Properties from the InRoads Menu and the Surface 

Properties dialog box will appear.  

 

 Click on the Advanced Tab (at the top of the Surface Properties dialog box.). 

 In the Surface: Pull-down – Ensure 1234567_SDE is selected. 

 

In the Cross Sections frame: 

 In the Symbology: Pull-down – select EXISTING 

 

In the Profiles frame: 

 In the Symbology: Pull-down – select EXISTING 

 

2. Save the InRoads Surface File 

After re-triangulating and compressing the DTM Surface – the data will need to be saved. As 

mentioned previously, InRoads retains the data in temporary memory but  

does not save the data on the fly. Whenever a change has been made to an   

 InRoads Surface Project – Save the project and its associated modifications or changes. 

 

Select FileSaveSurface from the InRoads Menu and save to the following location: 

 

C:\InRoads Data\PI#\SDE 

Example - C:\InRoads Data\1234567\SDE 

 

Please Note:  (The “Save As” dialog box may not appear because the Surface has already 

been saved initially). 

 

3. The PI#_SDE.dtm Surface Project is now ready for submittal. This file will be sent to the 

Office of Design Policy and Support/Location Bureau (Engineering Management / 

Operations Manager).  This data will then be forwarded to the Designer. 

 

*This .DTM file replaces the CAiCE .SRV file format. The DTM file contains all of the 

Features (random points, breaklines, border, obscured features, etc.) that used to be 

contained in the CAICE .SRV File.   
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4.2 Processing of the Geometry Project (.ALG) 
For detailed instructions regarding the generation and processing of the Survey Data and the 

creation of the Geometry data and objects – please refer to the “Introduction to InRoads for Survey 

Data Processing” Training Tutorial.  Detailed information for the processing of the Survey Data for 

Geometry Projects are listed and described in Labs 10-15. 

 

Following are some Quality Assurance Verification Items to review in order to ensure that an 

accurate Geometry Project is created: 

 

Geometry Project: 
 

 Point Prefixes shall not be utilized by the Surveyor/SDE when storing points in 

InRoads  

 All Alignments (for Parcels, Existing Centerlines, Existing R/W, etc.) stored in 

InRoads will have an SV Prefix pre-pended to the Alignment Name 

 The Surveyor/SDE shall work in the point range of 1-9999 

 If points beyond 9999 are needed, the SDE shall contact the Designer and request a 

range of points be set aside for the SDE to work in that the Designer will not use. 

 All Alignment Points must be converted to COGO Points in the InRoads Geometry 

Project. 

 Ensure that only ONE coincident COGO point is located at shared property corners. 

If this is not done - there may be issues when storing proposed Right of Way 

Alignments and creating Right of Way Tables. It also reduces plan clarity. 

 In InRoads all terminology for chains (whether it be Parcel Chains, Existing R/W 

Chains, or actual Existing Centerline Chains) are always referred to as 

“Alignments”.  

 All parcels must be stored clockwise and the alignments must close (first and last 

point number must be the same).   

 The beginning and the ending point of each curve should be equated to a point 

number and those numbers must be included in the parcel alignment. 

 

 

 

NOTE:  For more information about Property Resolution on GDOT and GDOT-sponsored 

projects, please see Appendix D of these guidelines. 

 

When the PI#_SDE.alg Geometry Project is ready for submittal, the file will be sent to the 

Office of Design Policy and Support/Location Bureau (Engineering Management / 

Operations Manager).  This data will then be forwarded to the Designer. 
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4.3 Generation of the Topographical, Property and Utility DGN File(s) 
After the final processing of the DTM Surface and the generation of the Geometry Project 

(.ALG) - Topographical, Property and Utility DGN file(s) will be generated for submission to 

Design.     

 

For detailed instructions regarding the generation and processing of these DGN files – please 

refer to the “Introduction to InRoads for Survey Data Processing” Training Tutorial.  

Detailed information for generating these DGN Files(s) are listed and described in Labs 16-

17. 

 

 

Table 4.1 

Standard DGN File Names 

 

Topographical DGN File Name PI#_TOPO.dgn 

Property DGN File Name PI#_PROP.dgn 

Utility DGN File Name PI#_UTLE.dgn 

 

 

Before submitting the DGN Files – perform the following steps in the [MicroStation 

Software] – 

 

For each DGN File - “Fit the Active View” so that all the data appears in the MicroStation 

View Window. 

 

1. Select FileSave As  from the [MicroStation Menu].   

 

Save the DGN File (Example: 1234567_TOPO.dgn) to the path shown below -- under the 

folder SDE --    

 

C:\InRoads Data\1234567\SDE             
 

 

2. In the [MicroStation Software] – 

 

Select FileCompressDesign from the [MicroStation Menu].   

(This will compress and reduce the size of the MicroStation file). 

 

When all associated DGN files are ready, the SDE is instructed to contact the Engineering Management 

/ Operations Manager and make copies available on SDEcommon.  The  Engineering Management / 

Operations Manager will keep all orignal copies and inform the designer where they may be acquired.  

The SDE is also instructed to obtain original copies from the Engineering Management / Operations 

Manager whenever enhancements are to be performed during the life of the project. 
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4.4 Listing of the SDE Project Deliverables 
After the DTM Surface (.DTM) and Geometry Project (.ALG) have been processed and the 

DGN files have been created - the files will be sent to the Office of Design Policy and 

Support/Location Bureau (Engineering Management / Operations Manager).  This data 

will then be forwarded to the Designer. 

 

 

The Final Deliverables include the following: 

 

 PI#_SDE.alg (InRoads Geometry file) 

 PI#_SDE.dtm (InRoads Digital Terrain Model) 

 PI#_TOPO.dgn (Existing Topo features) 

 PI#_PROP.dgn (Existing Property Information) 

 PI#_UTLE.dgn  (Existing Utility features) 

 PI#_PSR.xls (Property Statistics Report) 

 PI#_Misc.txt (Miscellaneous information SDE deems important.  This file may 

  not be included.) 

 A Survey Data Processing Quality Assurance Checklist Document 

 

 

 PLEASE NOTE: 

 

A Survey Data Processing Quality Assurance Checklist will be documented by the District 

SDE and/or Office of Design Policy and Support/Location Bureau and/or the Consultant Firm 

performing the Survey Data Processing work. This document lists several areas including the 

Survey Data, DTM Surface, Geometry Data and Final Deliverables which need to be verified 

before Project Submittal. This Document is a required Deliverable and will be submitted with 

the previously listed Deliverables. 

 

The following page contains the example Survey Data Processing QA form which will be 

completed and submitted. The Survey Data Processing Quality Assurance Checklist is 

available for download by navigating to the MicroStation and InRoads links from the 

following location:      

 
    http://www.dot.ga.gov/PS/DesignSoftware/InRoads 

  

 

 

 

 

  

   

 

 

 

 

http://www.dot.ga.gov/PS/DesignSoftware/InRoads
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Survey Data Project Deliverables InRoads Survey Data Processing Guidelines SS2 

 

4-11 

 



 

  

 

           5. 
Additional Survey Enhancements 

 

 

     

 

 

 

     

 

 

 
 

 



 

  

 

 

5. Additional Survey Enhancements 

During the life of a design project - Additional Survey Enhancements may need to be incorporated 

into the project and the new survey data re-submitted to the Designer in order for the Designer to 

update the design database. This section provides a brief summary of the processing/naming of 

Additional Survey Enhancements and the procedures to submit the processed data to the Designer.  

 

 All location survey data and all requests for additional survey data should be submitted 

to the Engineering Management Section of the Office of Design Policy and 

Support/Location Bureau. 

 

The processes for incorporating “Original” Enhancements to a Mapping Project are described in the 

“Introduction to InRoads for Survey Data Processing” Training Tutorial in Labs 8-9.  These same 

methods and processes are also utilized for incorporating Additional Survey Enhancements in a 

project. The process for adding additional enhancements will utilize the same procedures (except for 

the FWD and DTM file naming conventions which adds different alpha character(s) for enhancement 

tracking purposes).  

 

Depending on what type of enhancements are collected – the SDE will process the additional survey 

data and send the Designer the appropriate files as required. This could result in the SDE sending 

the Designer all of the updated files or just certain files depending on what data were collected. See 

examples below: 

*For Example – if only property enhancements were collected, then the SDE would send the 

Designer the new processed PI#_SDE.alg file and the associated enhanced data in the 

PI#_PROP.dgn file.  

*For Example – if only topographical enhancements were collected, then the SDE would send the 

Designer the new processed PI#_SDE.dtm file and the associated enhanced data in the 

PI#_TOPO.dgn file.  

In most cases the following files (or a combination) of these files will be submitted to the Designer 

for use as Additional Survey Enhancements: 

 PI#_SDE.dtm 

 PI#_SDE.alg  

 PI#_TOPO. dgn (if applicable) 

 PI#_PROP.dgn  (if applicable) 

 PI#_UTLE.dgn (if applicable) 

 

This section covers the following topics: 

 

● Additional Enhancements to the Survey Field Book (FWD) 

● Additional Enhancements to the Surface Project (DTM) 

● Additional Enhancements to the Geometry Project (ALG) 

● Additional Enhancements to the DGN Files (DGN) 
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Additional Survey Enhancement Process 
   (Red Dotted Line represents Additional Survey Enhancement Process Overview) 
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CSV File 
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go to Design 

 

Additional Field 
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Enhancements 

  

Designer Requests  
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Topo and 

Utle DGN 
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5.1 Additional Enhancements to the Survey Field Book (FWD) 
The following section depicts an overview of the processing/naming methods utilized to add 

additional enhancements to the Survey Field Book (FWD) File.  

When collecting the Additional Survey Data in the CSV files(s) the following naming 

scheme will be utilized: (See Table 5.1) 

*Also each of the intermediate additional enhancement ASCII files should be retained in a 

backup folder for future project reference and record retention.  

 

 

 Table 5.1 

 CSV File Naming Conventions (Enhancements) 

 

 File Type File Name 

  CSV– Full Field Survey File 

 

1st  (Original) Field Survey CSV 

2nd  Enhancement Field Survey  CSV  

3rd Enhancement Field Survey CSV, Etc. 

 

  

 

PI#A.csv                

PI#B.csv                

PI#C.csv, Etc.               

  CSV – Mapping Enhancement File 

 

Original Mapping Enhancement CSV 

1st  Mapping Enhancement CSV 

2nd Mapping Enhancement CSV, Etc. 

 

 

 

PI#XO.csv            

PI#XA.csv            

PI#XB.csv, Etc.            
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When importing the Additional Survey Data in the Survey Field Books the following 

naming scheme will be utilized: (See Table 5.2) 

*Also each of the intermediate additional enhancement Survey Field Book (FWD) files should 

be retained in a backup folder for future project reference and record retention. (The FWD files 

are Never submitted to the Designer). 

 

 

 Table 5.2 

 Survey Field Book File Naming Conventions (Enhancements) 

 

 File Type File Name 

  FWD – Full Field Survey File 

 

First (Original) Field Survey File 

Second Enhancement Field Survey File 

Third Enhancement Field Survey File, Etc. 

 

  

 

PI#_ A.fwd 

PI#_ B.fwd 

PI#_ C.fwd, etc. 

  

  FWD – Mapping Enhancement File 

 

Original Mapping Enhancement File 

First Mapping Enhancement File 

Second Mapping Enhancement File, Etc. 

  

 

PI#_ XO.fwd 

PI#_ XA.fwd 

PI#_ XB.fwd, etc. 

 

 

***Please Note***  
This FWD File is never submitted to the Designer. The data from this Survey Field Book will be 

imported into InRoads where it will then be processed into the DTM Surface File and/or the 

ALG Geometry File.   

 

 

 

 

 

 

 

 

 

 

 

 

 

For Detailed Step by Step instructions regarding the enhancements to the FWD File – 

please see the “Introduction to InRoads for Survey Data Processing” Training Tutorial 

Lab 8 – Section 8B. This Lab details the steps required to generate and process an 

Enhanced Survey Field Book (FWD). 
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5.2 Additional Enhancements to the Surface Project (DTM) 
The following section depicts an overview of the processing/naming methods utilized to add 

additional enhancements to the Surface Project (DTM) File.  

When incorporating/importing the Additional Survey Data in the DTM file`(s) the 

following naming scheme will be utilized: (See Table 5.3) 

*Also each of the intermediate additional enhancement DTM files should be retained in a backup 

folder for future project reference and record retention. (The intermediate DTM files are Never 

submitted to the Designer). 

 

 

 

 Table 5.3 

 DTM File Naming Conventions (Enhancements) 

 

 File Type File Name 

  
Intermediate DTM – Full Field Survey File 

 

Note:  

(The First Original Field Survey File is 

obtained from the PI#A.csv and PI#_A.fwd 

files. These files are incorporated as 

PI#_SDE.dtm during initial DTM creation – 

therefore there is no intermediate DTM named 

PI#_A.dtm.) 

 

2nd  Enhancement Field Survey File 

3rd Enhancement Field Survey File, Etc. 

 

  

 

  

 



                 See Note: 

 

 

 

 

PI#_ B.dtm 

PI#_ C.dtm, etc. 

 

 

  Intermediate DTM – Mapping File 

 

Original Mapping Enhancement DTM 

1st   Mapping Enhancement DTM 

2nd  Mapping Enhancement DTM, Etc. 

 

 

 

  

 

PI#_ XO.dtm 

PI#_ XA.dtm 

PI#_ XB.dtm, etc. 
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***Please Note***  

 Resolve all Crossing Segments and Mismatched Elevations in the additional survey data. 

 The intermediate DTM File(s) are never submitted to the Designer. The data from these 

file(s) are merged, incorporated and processed into the PI#_SDE.dtm file. This 

PI#_SDE.dtm file will be submitted to the Designer. It will be the Designer’s responsibility 

to rename the DTM file to PI#_Exist.dtm and copy this file into InRoads.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Detailed Step by Step instructions regarding the enhancements to the 

intermediate DTM File(s) and the incorporation/processing of the enhancement data 

into the original DTM (PI#_SDE.dtm)  – please see the “Introduction to InRoads for 

Survey Data Processing” Training Tutorial Lab 8 – Section 8C. This Lab details the 

steps required to generate and process an Enhanced Survey Surface Project (DTM). 
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5.3 Additional Enhancements to the Geometry Project (ALG) 
The following section depicts an overview of the processing/naming methods utilized to add 

additional enhancements to the Geometry Project (ALG) File.  

When incorporating/importing the Additional Survey Data in the ALG file the following 

naming scheme will be utilized: (See Table 5.4) 

 

 Table 5.4 

 ALG File Naming Convention (Enhancements) 

 

 File Type File Name 

  ALG - Geometry File PI#_ SDE.alg 

 

 

***Please Note***  

 There are no intermediate ALG files.  All of the enhanced Geometry data (Property, Existing 

R/W, etc.) are imported directly into the original Geometry File (PI#_SDE.alg).  

 There should be no conflict in points as long as the Survey Data does not use any point 

numbers previously collected in the original survey. The SDE will need to submit to the 

Surveyor a range of points to utilize for additional survey enhancements so that there will be 

no conflict in point names. 

 After the additional survey data is merged, incorporated and processed into the original 

Geometry File (PI#_SDE.alg) -- this PI#_SDE.alg file will be submitted to the Designer. It 

will be the Designer’s responsibility to utilize the InRoads LandXML Utility to incorporate 

the data from the PI#_SDE.alg file into the Design PI#_Design.alg file.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Detailed Step by Step instructions regarding enhancements to the Geometry File 

and the incorporation/processing of data into the original Geometry File 

(PI#_SDE.alg)  – please see the “Introduction to InRoads for Survey Data Processing” 

Training Tutorial Lab 8 – Section 8D. This Lab details the steps required to add and 

process additional survey data to the Geometry Project. 
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5.4 Additional Enhancements to the DGN Files (DGN) 
The following section depicts an overview of the processing/naming methods utilized to add 

additional enhancements to the DGN Files.  

After the Survey Enhancements are added to the InRoads database(s) (Surface and/or Geometry 

databases), the enhanced data from both the DTM (the topographical/utilities aspect) and the 

Geometry (Property information) will need to be exported from InRoads.  

 The TOPO DGN enhancements will be created in “intermediate” DGN files (as needed) 

and then merged into the original TOPO File which will then be submitted to the 

Designer. The Designer will then utilize this “new enhanced” TOPO DGN. 

 A “new” UTLE DGN file which includes all of the utility data, etc.  (Not just the new 

enhancement data) will be re-created from InRoads and then submitted to the Designer. 

The Designer will then utilize the new UTLE DGN file. 

 A “new” PROP DGN file which includes all of the property data, etc.  (Not just the new 

enhancement data) will be re-created from InRoads and then submitted to the Designer. 

The Designer will then utilize the new PROP DGN file. 

 

5.4.1 TOPO Enhancements (Topographical DGN) 
 

When incorporating the Additional Survey Data in the “Intermediate” TOPO DGN file, 

the following intermediate naming scheme will be utilized:   (See Table 5.5) 

 

 

 Table 5.5 

 Intermediate TOPO DGN Files (Enhancements) 

 

 File Type File Name 

  Intermediate TOPO (Full Field Survey) 

1st  Enhancement DGN 

2nd  Enhancement  DGN  

3rd Enhancement DGN, Etc. 

 

 

P I#_A.dgn 

PI#_B.dgn 

PI#_C.dgn, etc. 

 

  
Intermediate TOPO  (Mapping Enhancement) 

1st  Mapping Enhancement DGN 

2nd  Mapping Enhancement DGN 

3rd  Mapping Enhancement DGN, Etc. 

 

 

PI#_ XA.dgn 

PI#_ XB.dgn 

PI#_XC.dgn 
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Process to create a “Merged” PI#_TOPO.dgn file: 
 

1. The user will incorporate the Additional Survey Data into the InRoads FWD and DTM 

databases. (See “Introduction to InRoads for Survey Data Processing” Training Tutorial 

Lab 8B – Section 8C” for detailed instructions on adding Additional Survey Data to the 

FWD/DTM in InRoads).  

 

2. An intermediate TOPO DGN file -- Example (1234567_XA.dgn, 1234567_XB.dgn, etc.) 

will be created from the field enhanced DTM/FWD in InRoads.  (See “Introduction to 

InRoads for Survey Data Processing” Training Tutorial Lab 17 – Section 17B” for 

detailed instructions on creating an Intermediate TOPO DGN file).  

 

3. Before merging the enhanced data into the “original” PI#_TOPO DGN – the user will need 

to go to the “original” PI#_TOPO.dgn and clip out any conflicting or outdated MicroStation 

information. This includes any obscured area boundaries that need to be deleted and any data 

that will be in conflict with the new topographical data. 

 

4. The TOPO enhancement DGN file will then be merged with the “original” submitted 

PI#_TOPO.dgn file. This will ensure that all of the original Mapping Data is represented. 

(See “Introduction to InRoads for Survey Data Processing” Training Tutorial Lab 17 – 

Section 17C” for detailed instructions on merging data into the PI#_TOPO.dgn file).  

 

5. The merged and updated PI#_TOPO.dgn file is then submitted to the Designer. The Designer 

will then utilize the new enhanced PI#_TOPO.dgn file for use in project design. (See Table 

5.6) 

 

 

When incorporating the Additional Survey Data with the Original TOPO data in the 

merged TOPO DGN file, the following naming scheme will be utilized: (See Table 5.6) 

 

 Table 5.6 

 Merged TOPO DGN File (Enhancements) 

 

 File Type File Name 

  Merged TOPO DGN File P I#_TOPO.dgn 
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5.4.2 UTLE Enhancements (Utility DGN) 
 

When incorporating the Additional Survey Data in the UTLE DGN file, the following 

naming scheme will be utilized: (See Table 5.7) 

 

 Table 5.7 

 UTLE DGN File (Enhancements) 

 

 File Type File Name 

  UTLE DGN File PI#_UTLE.dgn 

 

 

***Please Note***  

 There are no intermediate UTLE DGN files.  All of the original and enhanced data for 

Utilities will be re-created from InRoads and then submitted to the Designer in a new 

PI#_UTLE.dgn file.  

 The SDE will of course remove any obsolete InRoads utility data that has been replaced by 

new utility data as applicable. The Designer will then utilize the new PI#_UTLE.dgn file. 

 (See “Introduction to InRoads for Survey Data Processing” Training Tutorial Lab 17 – 

Section 17D” for detailed instructions on creating the new UTLE DGN file).  
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5.4.3 PROP Enhancements (Property DGN) 
 

When incorporating the Additional Survey Data in the PROP DGN file, the following 

naming scheme will be utilized: (See Table 5.8) 

 

 Table 5.8 

 PROP DGN File (Enhancements) 

 

 File Type File Name 

  PROP DGN File PI#_PROP.dgn 

 

 

***Please Note***  

 There are no intermediate PROP DGN files.  All of the original and enhanced data for 

property will be re-created from InRoads and then submitted to the Designer in a new 

PI#_PROP.dgn file.  

 The SDE will of course remove any obsolete InRoads Property or Existing R/W data that 

has been replaced by new Property and/or Existing R/W data as applicable. The Designer 

will then utilize the new PI#_PROP.dgn file. 

 (See “Introduction to InRoads for Survey Data Processing” Training Tutorial Lab 16 for 

detailed instructions on creating the new PROP DGN file).  
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5.5 Overview of Additional Survey Enhancements   
  

As mentioned previously – the SDE will submit all or a combination of the following files 

to the Designer when Additional Survey Enhancements are required. 

 

 PI#_SDE.dtm 

 PI#_SDE.alg  

 PI#_TOPO. dgn (if applicable) 

 PI#_PROP.dgn  (if applicable) 

 PI#_UTLE.dgn (if applicable) 

 

Depending on the job and the file(s) required – the SDE will submit the updated file(s) 

following the format listed in this Document. 

 

For Detailed Information regarding the procedures for incorporating Additional Survey 

Enhancements - please see the following: 

 

SDE Training Lab - Introduction to InRoads for Survey Data Processing: 

 

Training Tutorial Labs 

Lab 8 

Lab 9 

Lab 16 

Lab 17   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



     

 

 

 

 

Appendix A 
One Point on Chain Check 

 

 

     

 

 

 

     

 

 

 
 



     

 

 

 

APPENDIX A ONE POINT ON CHAIN CHECK 

 

General Information: 

Prior to exporting field collected data from the InRoads Survey Field Book (FWD) to an InRoads 

Surface DTM file and an InRoads Geometry ALG file, the data should be reviewed for a one point 

on chain collection error.  A one point on chain error occurs during field collection when an 

alignment code is entered into the data collector and then only one point is collected for that code.  

An alignment requires the collection of two or more points to be considered an alignment.  Checking 

for a one point on chain error may be performed in the InRoads Survey FWD file. 

 

 

Procedure to Check for a One Point on Chain Error 

 

1. Create an InRoads Survey FWD file.  For detailed instructions on creating an InRoads 

Survey FWD file, see Lab 2 of the Introduction to InRoads-SDE Training Material. 

2. Load the field collected CSV file into the InRoads FWD.  For detailed instructions 

describing the import process of field collected survey data, refer to Lab 2 of the 

Introduction to InRoads-SDE Training Material. 

3. Open the InRoads Survey Field Book.  This is accomplished in InRoads by selecting 

Survey ► Fieldbook Data…   

4. Look for One Point on Chain errors.  One Point on Chain errors are identified in the 

Observations:  field of the InRoads Fieldbook in bold black text as shown here. 

 

 
 

5. One point on chain errors are to be resolved in the original field surveyed CSV file prior 

to continuing work in InRoads. 

 

 

One Point on Chain errors are highlighted in 

bold black text in the Observations:  field of 

the Fieldbook.  Points 21 and 29 are 

examples of One Point on Chain errors 

identified in bold black text. 



 

  

 

Appendix B 
Stakeout Data Using InRoads LandXML 

 

 

     

 

 

 

     

 

 

 
 

 



 

  

 

APPENDIX B STAKEOUT DATA USING INROADS LANDXML 

 

The following procedure is used to export Stakeout Data such as COGO Points, 

Horizontal/Vertical Alignments, etc. from InRoads to a LandXML file. This LandXML file 

can then be uploaded to the GDOT Trimble Business Center/GDOT Trimble Data Collectors 

for use in staking out Survey Data. 

 

Workflow Procedure: 

Open the InRoads ALG file. Then utilize the LandXML Translator to select the COGO 

Points and Horizontal/Vertical alignments which will be written out to create the 

LandXML File. 

 

Feature Styles to Export to LandXML for Stakeout: 

 PROP_E_PAR  PROP_E_RWE  PROP_E_RWM 

 PROP_E_RWC  PROP_E_RWU  PROP_E_POEL 

 PROP_E_PPC  PROP_E_PCF  TOPO_E_SNGSCM 

 TOPO_E_SLCM  TOPO_E_SLCD  TOPO_E_SDCD 

 TOPO_E_SBNCHMK  REQD_P_*  MAIN_P_CONSTCL 

 MAIN_P_SIDECL   

  

Workflow Steps: 

 
A. Open the Geometry Project (.ALG) in InRoads 

1. In InRoads, select File Open 

 

2. Set the Files of type:  Geometry Projects (*.alg) 

 

3. Select the .ALG File (Geometry Project) that contains the Cogo Points and 

Alignments that are to be exported to the LandXML file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

  

 

 

B. Create the LandXML File 

1. In InRoads, select File TranslatorsLandXML Translator 

 

2. Select the Export Alignment tab 

 

3. Select the Geometry Project: 

 

4. Click in the Include: field to activate the Filter button 

 

5. The Geometry Selection Filter dialog box opens. Select all of the Alignments that are 

to be included in the XML file. Then click OK. 

 

6. Ensure that LandXML: Version 1.0 is selected. 

 

7. Check the box to “Include All Cogo Points”.  

Note: This box can be left unchecked if no Cogo Points need to be included in the 

             LandXML file. 

 

8. Important - Change the Linear Units to: US Feet 

 

9. Change the State: to  proposed 

10. Click the Save As button. The Export dialog opens. Key in the File Name: and click 

Save. 

 

11. In the File Name: field - the name of the file will be listed. 

 

12.  Ensure your dialog box is similar to the one depicted below: 

Note: If the LandXML file is written by Survey, the ALG file Name will be PI#_SDE. 

      If the LandXML file is written by Design, the ALG file Name will be PI#_Design. 

 



 

  

 

                                 
 

 

13. Next, click Close to close the dialog box. 

 

14. The LandXML file will be created in the Path depicted in the File Name: field. 

 

 

 

 

 



 

  

 

Appendix C 
USACE 404 Permit Procedure For 

Perennial Streams – Culverts 

 

 

     

 

 

 

     

 

 

 
 



 

  

 

APPENDIX C  

                                              USACE 404 PERMIT PROCEDURE  

                                        FOR PERENNIAL STREAMS - CULVERTS 

 

General Information: 

In order to conform to the United States Army Corps of Engineers (USACE) 404 Permit requirements 

for Perennial Streams – Culverts, GDOT has established the following standards and workflow 

procedures for incorporating the survey data into the InRoads Survey/Design Software. For new 

proposed culverts and for existing culvert replacements over Perennial Streams, an updated Survey of 

the area will be provided in a Digital Terrain Model format. This area of survey will encompass 100 

feet upstream from the end of proposed or replacement culvert and 100 feet downstream from the end 

of proposed or replacement culvert for a total minimum coverage of 200 feet. For additional 

information regarding the field survey collection procedures, please see the GDOT Survey Manual 

located on the ROADS page at the following link: 

 

http://www.dot.ga.gov/PartnerSmart/DesignManuals/SurveyManual/SurveyManual.pdf 

 

 

Feature Styles for Stream Bank-Full and Stream X-Sections 

Feature Style Description Point Type 

 TOPO_E_SBF  Stream Bank-Full  3D – Non-
Triangulated 

 TOPO_E_SXS  Stream X-Section  3D – Non-
Triangulated 

 

 

Workflow Procedure: 

The Perennial Stream field survey data will be provided in a .CSV file format. The .CSV file 

will then be imported into an InRoads Survey Field Book (.FWD file). A new DTM Surface 

will be created and the field book data imported into this surface. The DTM will then be 

triangulated and any crossing segments will be resolved. If there are multiple culverts on the 

project, a .CSV file will be provided for each culvert area. These .CSV files will then be 

imported into each respective .FWD file and .DTM file corresponding to the name of the 

associated .CSV file(s).  

 

 NEVER merge the 404 Permit DTM Data into the original DTM containing the 

Existing Surface. 

 

 The triangulated DTM containing the 404 Permit Data will be provided to the 

Designer.  

 

 No DGN files of the 404 Permit Topographic data will be created or provided to 

the Designer. 

 

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/SurveyManual/SurveyManual.pdf
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/SurveyManual/SurveyManual.pdf
http://www.dot.ga.gov/PartnerSmart/DesignManuals/SurveyManual/SurveyManual.pdf
http://www.dot.ga.gov/PartnerSmart/DesignManuals/SurveyManual/SurveyManual.pdf


 

  

 

    

 

Standard File Naming Conventions: 

 

   ** File Type File Name 

  CSV – Field Survey for Perennial Streams 

 

1st  Field Survey CSV 

2nd Field Survey CSV 

3rd Field Survey CSV, Etc. 

 

  

 

PI#CA_404 Permit.csv              

PI#CB_404 Permit.csv              

PI#CC_404 Permit.csv, Etc.      

  FWD – Field Survey for Perennial Streams 

 

1st  Field Survey File 

2nd Field Survey File 

3rd Field Survey File, Etc. 

 

  

 

PI#CA_404 Permit.fwd 

PI#CB_404 Permit.fwd 

PI#CC_404 Permit.fwd, Etc. 

  

  DTM – Field Survey for Perennial Streams 

 

1st  404 Permit DTM 

2nd 404 Permit DTM   

3rd 404 Permit DTM, Etc. 

  

 

PI#CA_404 Permit.dtm 

PI#CB_404 Permit.dtm 

PI#CC_404 Permit.dtm, etc. 

  

 

 

 

Key To Naming Conventions: 

File Name File Denotation 

 1234567CA_404 Permit 1234567=         PI Number 
CA =                  Culvert Location A 
404 Permit =   Type of Surface 

 

 1234567CB_404 Permit 1234567=         PI Number 
CB =                  Culvert Location B 
404 Permit =   Type of Surface 

 
 



 

  

 

 

 

Workflow Steps: 

The following procedure contains a brief outline of the processes used to import a CSV file into 

the Survey Field Book (FWD), then create and import the Survey Data into the (DTM). A 

triangulated DTM Surface will then be submitted to the Designer. For Detailed information 

regarding the FWD and DTM creation, generation and review - please see the Introduction to 

InRoads_Survey Training Material located on the GDOT web page at the following link: 

 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InR

oads_Survey.pdf 

 

 
A. Create the (.FWD) in InRoads 

 

1. In InRoads, select File New 

2. Click the Survey Data tab. 

3. In the Name: field enter 1234567CA_404 Permit 

4. Click Apply and then Close. 

 

B. Create the (.DTM) in InRoads 

 

1. In InRoads, select File New 

2. Click the Surface tab. 

3. In the Type: pull-down, enter Existing 

4. In the Name: field enter 1234567CA_404 Permit 

5. In the Description: field enter 404 Permit Surface 

6. In the Maximum Length: field enter 300 

7. In the Preference: field enter Existing 

8. Click Apply and then Close. 

 

C. Import the .CSV file into the Survey Field Book (.FWD) 

1. In InRoads, select FileImport Survey Data 

2. Browse to the CSV File to import (Ex. 1234567CA_404 Permit.csv) 

3. Click Import and then click Close. 

 

 

 

 

 

 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_Survey.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_Survey.pdf


 

  

 

 

D. Import the .FWD Topo Data into the Surface (.DTM) 

1. In InRoads, ensure the Filter Lock has a check mark next to it by going to 

ToolsLocksFeature Filter  

2. In InRoads, select Survey Survey Style Filter 

3. In the Filter Name: field, select DTM Surface Codes. Then click OK. 

4. Next, select Survey Survey Data To Surface 

5. In the Surface Name: pull-down, enter 1234567CA_404 Permit 

6. Click the Preferences.. button – then select GDOT, click Load and Close. 

7. Then click OK.  

8. In the Triangulate Surface dialog, select the 1234567CA_404 Permit and click Apply 

and then click Close. 

E. Save the FWD (Survey Field Book) and DTM (Surface File) 

1. In InRoads, select FileSaveSurvey Data. Then browse to a location to save the file. 

Click Save and then click Cancel.  

2. In InRoads, select FileSaveSurface. Then browse to a location to save the file. Click 

Save and then click Cancel.  

 

F. Review the DTM Features/Triangles for any spikes and resolve any chain crossings. 

NOTE: For detailed information regarding these steps, please see Lab 4 and Lab 6 in the 

Introduction to InRoads_Survey Training Material. This document is located at the 

following link on the GDOT web page: 

 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20In

Roads_Survey.pdf 

 

 

G. Submit the DTM(s) to the Designer 

Note:  
After reviewing the DTM and correcting any spikes or errors in the surface data - the 404 Permit  

Surface and/or Multiple 404 Permit surfaces (if applicable) are ready for submission to the  

Designer. 

 

                         

 

 

 

 

 

 

http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/INROADS/Introduction%20to%20InRoads_Survey.pdf
http://www.dot.ga.gov/doingbusiness/PoliciesManuals/roads/INROADS/Introduction%20to%20InRoads_Survey.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_Survey.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Introduction%20to%20InRoads_Survey.pdf


 

  

 

Appendix D 
Property Resolution on GDOT and GDOT-

Sponsored Projects 

 

 

     

 

 

 

     

 

 

 
 



 

  

 

APPENDIX D 

PROPERTY RESOLUTION ON GDOT AND GDOT-SPONSORED PROJECTS 
 

GDOT’s practice to prevent conflicts, disputes and to insure accurate property databases is to hold to 

property pins in the resolution. 

This section applies to consultants and GDOT in-house personnel who perform property and right of 

way resolution on GDOT sponsored projects. It has always been GDOT’s in-house procedure to hold 

to field located monumentation that reasonably fits the deeds, plats and ROW information of the 

corridor parcels unless senior rights or another contrary intent indicated by a deed dictates it should 

not. The term “reasonably fits” would be the tolerance that a competent Georgia Registered Land 

Surveyor would use based on his experience and professional judgment. 

With this in mind, most property owners can point out their property corners or other monumentation 

as it relates to their property. Neighbors often agree that a monument is their dividing corner even 

though it may be off 2 tenths of a foot from the deed measurement. 

Below are excerpts from the Georgia Land Surveying History and Law publication written by Farris 

W. Cadle. Be mindful these excerpts are not law, but principles for good surveys. 
 
 
 

 

 
 
(Page 398- Georgia Land Surveying History and Law, Farris W. Cadle, 1991 University of Georgia 

Press) 



 

  

 

 
 
 
 
 
 
 
 

 
 

 

(Page 402-403 Georgia Land Surveying History and Law, Farris W. Cadle, 1991 University of 

Georgia Press) 

 

 

 



 

  

 

 

 

(Page 403- Georgia Land Surveying History and Law, Farris W. Cadle, 1991 University of Georgia 

Press) 

 

Rotated Property Geometry 

All GDOT projects are surveyed on the state plane coordinate system. With this in mind, all parcels 

should be individually rotated from magnetic north to grid north for the best possible property 

resolution. 

For future in-house and consultant database checks, GDOT will be assessing if field located 

monuments are being held in property resolution. If a marker is not held to, GDOT may require an 

explanation. Checks will also be made to verify if the parcels have been rotated. 

If you have any questions on this matter please contact: 

GDOT Statewide Consultant Compliance Supervisor 404-699-4449 

GDOT Statewide Survey Data Specialist 404-699-4446 


